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Eighth Edition February 2003 
This edition applies to Version 5.0, GA of WebSphere Development Studio Client and 
to all subsequent releases and modifications until otherwise indicated in new editions.  
 
IBM welcomes your comments. You can send comments to: 
 
IBM Canada Ltd. Laboratory 
Information Development 
B3/KB7/8200/MKM 
8200 Warden Avenue 
Markham, Ontario, Canada, L6G 1C7 
 
You can also send your comments electronically to IBM.  See “How to send your 
comments”. 
 
When you send information to IBM, you grant IBM a nonexclusive right to use or 
distribute the information in any way it believes appropriate without incurring any 
obligation to you. 
 
© Copyright International Business Machines Corporation 2001, 2002. All rights 
reserved. 
US Government Users Restricted Rights – Use, duplication restricted by GSA ADP 
Schedule Contract with IBM Corp. 
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Notices 
This information was developed for products and services offered in the U.S.A. IBM may not 
offer the products, services or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply 
that only the IBM product, program, or service may be used. Any functionally equivalent 
product, program, or service that does not infringe any IBM intellectual property right may be 
used instead. However, it is the user’s responsibility to evaluate and verify the operation of any 
non-IBM product, program, or service. 

 
IBM may have patents or pending patent applications covering subject matter in this 
document. The furnishing of the document does not give you any license to these 
patents. You can send license inquiries, in writing, to: 
 
Director of Licensing 
Intellectual Property & Licensing 
International Business Machines Corporation 
North Castle Crive, MD – NC119 
Armonk, New York 10504-1785 
U.S.A 
 

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND,K EITHER EXPRESS 
OR IMPIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you. 
 

This information could contain technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions 
of the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 

 
Any references in this information to non-IBM Web sites are provided for convenience 
only and do not in any manner service as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product and use 
of those Web sites is at your own risk. 
 
Licencees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 
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IBM Canada Ltd. Laboratory 
Information Development 
B3/KB7/8200/MKM 
8200 Warden Avenue 
Markham, Ontario 

Canada L6G 1C7 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases payment of a fee. 
 

The licensed program described in this information and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement, or any equivalent agreement between us. 

 

Programming Interface Information 
This publication is intended to help you to create and manage applications and user interfaces 
on the workstation, in a client/server environment. It contains examples of data and reports that 
are used in daily business operations. To illustrate them as completely as possible, the 
examples include the names of individuals, companies, brands, and products. All of these 
names are fictitious and any similarity to the names and addresses that are used by an actual 
business enterprise is entirely coincidental. This publication documents General-Use 
Programming Interface and Associated Information provided by IBM WebSphere Development 
Studio Client for iSeries. 

 

Trademarks and Service Marks 
The following terms are trademarks or registered trademarks of the International Business 
Machines Corporation in the United States or other countries or both: 

Application System/400 
AS/400 
AS/400e 
DB2/400 
IBM 
iSeries 
Integrated Language Environment 
OS/400 
RPG/400 
VisualAge 
WebSphere 
 

Java and all Java-based trademarks are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the United States and/or other countries. 
 
Microsoft, Windows, and Windows NT are trademarks or registered trademarks of Microsoft 
Corporation in the United States, or other countries, or both. 
Other company, product, and service names may be trademarks or service marks of others. 



WebFacing hands-on Lab                                                                       Page 6 of 220 

 CW                                                                                                  © Copyright IBM Corporation 2002 
Course material may not be reproduced in whole or in part 

without the prior consent of IBM 

Overall Lab Guide  

 
The objective of the WebFacing tool lab is to have the students work with an existing 
5250 application and use the WebFacing tool to create a browser based user 
interface, and then run this application as an e-business application. At the end of the 
lab, the student should know how to use the WebFacing tool and how to customize 
the WebFacing environment to meet his/her requirements for an e-business 
application. The Lab will guide the student  through most of the steps involved in the 
process of using the WebFacing tool. Using the WebFacing tool Wizards and the 
CODE Designer will allow you to customize the outcome of the conversion process.  
.  
 
.  
 

Note: The pictures in these labs show a similar application being built. Some of the 
names and icons may be different from the environment you are working with.  
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The Steps in this Lab 

� Familiarize yourself with the 5250 application 
� Start WDSc and open the WebFacing tool perspective 
� Use the WebFacing tool project wizard to create a 

project for this application 
� Convert the DDS source to web definitions 
� Run the WebFaced application in the WAS test 

environment 
� Customize the WebFaced application with CODE 

designer 
� Customize the WebFaced application by changing 

WebFacing project properties 
� Add dynamic authentication to the WebFaced 

application  
� Optional exercises 

§ Create a Web Application in WebSphere Application 
Server (WAS) on iSeries 

§ Run the WebFaced application using the iSeries 
WAS environment 
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Prerequisites 
Although not required, familiarity with the DDS language is preferred. Also it will be 
helpful to understand how Web applications work. Knowledge of the concepts of 
Servlets and Java Server Pages is not required  but will be helpful in understanding 
the generated output of the WebFacing tool.     
 
Also, it is helpful if the student is familiar with basic MS Windows Graphical User 
Interface (GUI) operations such as working with the desktop and basic mouse 
operations such as opening folders and performing drag-and-drop operations. The 
student should also be familiar with a browser and know how to navigate through the 
Internet. 
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 2 

Exercise: A Look at the Green Screen User 
Interface 

In order to be able to complete this exercise, you need the sample Order 
Entry application on your iSeries server. The installation and setup has been 
done in this Lab by the instructor previous chapter 

REVIEWING the 5250 APPLICATION 
You are ready to have a look at the sample application that you will use for 
the WebFacing exercise soon. You are going to explore the application by 
invoking it from a 5250 session and working with the applications green 
screens and command keys. This will also test your user profile setup. If you 
can run this application directly without changing the job environment on the 
iSeries, the WebFacing conversion and the WebFacing server will not have 
problems during the remaining exercises later. If you have problems make 
sure the library list for your job is setup correctly to include library 
WFLABXX at job start up. 
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The Goal of the Exercise 
The goal of this exercise is to provide you the opportunity to explore the 
5250 application, before you start and use the WebFacing tool to convert it. 
This will allow you to become familiar with the 5250 screens and the 
behavior of the application. After the conversion with WebFacing tool you 
can then easily compare the 5250 and the Web user interface. 
At the end of the exercise, you should be able to:  

• Invoke the application 
• Know what screens the application provides 
• Know how the application works in its 5250 environment   
• Know what command keys are supported and what functions they allow 

Scenario 
You use a 5250 emulation screen to start the sample Order Entry 
application. In this application you will be prompted with the first screen for 
a customer number. You will work with the help panels this application 
provides. You will select a customer from a list of valid customers and then 
go thru the exercise of filling an order for this selected customer. You will 
fill the order by selecting a part from a list and adding it to the order by 
specifying the quantity ordered. After all parts and their quantities for this 
order have been specified you complete the order by pressing a specific 
command key. The application will then prompt you for a new customer 
number to handle the next order 

Starting the 5250 application 
To start the order entry application you need a 5250 emulator on your 
workstation. Please start a5250 emulation screen. 

Signing on to the iSeries system and calling the Order 
Entry application 
On the 5250 emulation screen on your desktop, displaying the sign-on 
screen.  

• Enter User ID and password, which you setup in the steps before, for this 
WebFacing sample. It will start a job that has library WFLABXX in its library list.  

On the command line of the 5250 screen 

• Invoke the Order Entry Application by typing: CALL ORDENTR 
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The application starts and shows the first panel as shown in Figure 0-1. This 
first screen prompts for a customer number, you have choice of keying in the 
customer number d irectly or you can display a window that shows a 
selection list of existing customers by pressing function key 4. 

Figure 0-1: Order Entry application first panel  

Before you go ahead with the order entry process, try the help. This 
application uses User Interface Manager (UIM) help. Yo u will also convert 
these UIM help panels with the WebFacing tool. To understand the results of 
the UIM help conversion, I suggest you try the help now here in the 5250 
environment and then later in the browser. 

Using online help  
• Move the cursor to the customer number entry field 
• Press command key 1  

Panel group help will be displayed, see Figure 0-2 
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Figure 0-2:UIM help panel for customer number 

• To get more help, move the cursor underneath the 1 in the help area and press 
the enter key  

Figure 0-3 shows a sample of the panel that appears 
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Figure 0-3:Help for requesting a customer list 

• Press command key 12 to get back to the help for the customer number field 
• To get help for the second choice, move the cursor underneath the 2 in the help 

area and press the enter key 
 Now you see detailed help for keying in the customer number, see Figure 0-4 
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Figure 0-4: Detailed help for specifying a valid customer number 

• Press command key 12 to get out of the help for the customer number field 
On the main help panel in the Select customer – Help area 

• Press command key 2 to get to the extended help 
Figure 0-5 shows the extended help for the customer number field 
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Figure 0-5:Extended help panel for customer number 

• Press command key 12 to get out of the extended help for the customer number 
field 

• Press command key 12 again to get out of the help for the customer number field 
On the application customer number input panel: 

• Move the cursor near the order number field 
• Press command key 1  

Context sensitive help for this area will be displayed, as shown in Figure 0-6  
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Figure 0-6:Help for order number 

• Press command key 12 to get out of the help for the order number field 

Selecting a customer 
Now you have an understanding how the help panels in this application work 
and look. You now need to identify the customer this order is related to. You 
have the choice of specifying a valid customer number, or you can get a 
selection list of valid customers. I want you to use the selection list to 
because it uses the WINDOW DDS keyword and I want to illustrate to you 
how the WebFacing tool converts a DDS window. 

• Press command key 4  to display the customer selection list. 
A list of customers gets displayed in a window, as shown as in Figure 0-7. 
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Figure 0-7:Customer list panel  

• Select a customer by typing 1 in the Options field. 
• Press the Enter key to proceed. 

This brings you back to the initial panel now filled with detailed data for the 
selected customer, as shown in Figure 0-8. You’ll notice that an order 
number has been assigned as well. You are ready to order some parts. 
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Figure 0-8:Order entry panel with detail customer data 

Filling the order  
The process of selecting parts is similar to the way you selected a customer 
in the previous step. You are able to key in the part number directly or select 
the part from a selection list. I want you to thru the parts selection list. 
On the order entry panel,  

• Press command key 4, to get a list of available parts 

You get a parts list in a window as shown in Figure 0-9. 
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Figure 0-9:Part selection list 

• Select a part that has lots of quantity left by typing 1 in the Options field. 
Back on the order screen, the part appears in the order; on the top line of the 
parts list, as shown in Figure 0-10 
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Figure 0-10:Specify parts quantity 

To order a certain quantity of this part 
• Change the quantity field to a value, for example two as in figure 2-10. 
• Press the Enter key to add the part and quantity ordered to the order. 

The detail order line for this part, with the quantity specified, is now part of 
this order, as shown in Figure 0-11. 
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Figure 0-11:One item added to order 

 Add more parts, by going to thru the part selection again, go thru the 
following three steps until you have added all parts that belong to this fictive 
order: 

1. Go to the parts list, by pressing command key 4  on the order panel,  

2. Select a part from the parts list, 

3. Specify the parts quantity 

After you feel the order is complete go the next step 

Completing the order 
On the order entry panel: 

• Press command key 6, to accept the order. 

The order gets added to the database and the next order can be handled, you are back on 
the starting screen of the application. 

You have worked with all panels in this application, 
1. The start order entry panel 
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2. Several help panels  

3. The customer list window 

4. The full order entry panel 

5. The parts list window 

I leave it up to you, whether you want to add more orders. 
If you think you understand how the user interface of this application works, 
stop adding orders.  
• Press command key 3  to exit the application. 

You are now ready to put a brand new user interface onto this application. 

Analysis 
You completed exercise: A look at the green screen user interface. Here is 
what you did:  

1. Started a 5250 emulation session,  

2. Signed onto the iSeries system,  

3. Started the order entry application. 

4. Used the help panels in this application 
5. Selected a customer from the customer selection window 

6. Selected parts from the parts selection window 

7. Ordered a certain quantity of parts for the order 

8. Completed the order  

9. Exited the application.  

You are ready to move on. 
Next you will create a WebFacing project.  
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EXERCISE: CREATING A WEBFACING 
PROJECT  

Before you can create a Web user interface for the Order Entry Application, 
you need to create a WebFacing project. A WebFacing project is a complete 
web project with the directory structure and files needed to conform to the 
Java 2 platform, Enterprise Edition (J2EE) standard of a web application, it 
also contains additional information unique to WebFacing, like the source to 
be converted. 

 

The Goal of the Exercise 
The goal of this exercise is to practice using the WebFacing project wizard 
inside the WebSphere Development Studio Client (WDSC) workbench to 
create a new WebFacing project. You will then use this WebFacing project 
to facilitate the conversion of your DDS source and to test the generated 
output. 
At the end of the exercise, you should be able to: 
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• Start the Development Studio Client workbench 
• Start the WebFacing tool project wizard  
• Step through the project wizard pages 
• Provide the correct input to the project wizard 
• Browse through the new project 

Scenario 
Before you can use the WebFacing tool to reface your application you need 
to create a WebFacing project in the Development Studio Client workbench. 
The first step in a when starting with the WebFacing is to create a 
WebFacing project You will identify the pro ject information, like the DDS 
source member names to be WebFaced, and they will be stored in a 
workspace on your workstation. This exercise guides you thru the process of 
identifying the DDS and Panel Group source members to be converted by 
the WebFacing tool. It also goes thru specifying some of the runtime 
information you will need later when running the WebFaced application.  

Before you start 
To run this exercise you need WebSphere Development Studio Client for 
iSeries Version 5 or 4 installed on your workstation. Short instructions on 
how to install the product are provided in Chapter 1. 
The figures in this book show sample user interface snapshots based on a 
workspace that has not been used before, if you already used the product 
your environment will be slightly different and you need to adjust for that 
fact when following my instructions or comparing my screen shots with your 
real desktop environment. 

Starting the Development Studio Client workbench 
Now go ahead and start Development Studio Client: 

 
Figure 0-1: Starting WebSphere Development Studio Client Version 5 

On your desktop task bar,  
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• Click: Start > Programs > IBM WebSphere Studio >Development Studio 
Client for iSeries 

A dialog as shown in Figure 0-2, will appear asking you for the workspace 
location, unless you used the Development Studio Client before and selected not 
to show this dialog again. The workspace contains all the information about your 

Development Studio projects, you can accept the default or store the work 
related to the WebFacing exercises in this book, in a separate workspace. You 

can always start with a new workspace later, if you don’t want to mix these 
exercise WebFacing projects with your real work. 

 
Figure 0-2: Dialog for workspace selection 

• Name the directory of the workspace as shown in Figure 0-2, use the 
directory name wflabxx (xx being your team number) 

• Click the OK push button  
After a few moments of loading, the workbench opens, and a 
window similar to the one shown in Figure 0-3 will appear on 
your desktop 
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Figure 0-3:Initial window of Development Studio Client 

 

Note: If you didn’t reset the workbench, or you are working with the 
advanced version of Development Studio Client, or you are 
working with Development Studio Client Version 4, your 
environment will differ slightly from the screen captures in this 
book. 

Opening the WebFacing perspective 
The Development Studio Client shows the Remote System 
Explorer (RSE) perspective by default. This is the perspective 
that you would use to work with iSeries objects. It allows 
specifying connections to iSeries servers and provides for the 
programmer a similar interface to iSeries objects as the 
Program Development Manager (PDM) does in a green screen 
environment. 
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The WebFacing tool provides it’s own perspective since it 
needs to give its users access to unique views and tools 
targeted towards the WebFacing task. 
To create a WebFacing project you first need to open the 
WebFacing perspective. 

 
Figure 0-4: Workbench Menu structure for opening a perspective 

  
 Do this by: 

• Selecting the Window menu item on the workbench menu bar. 
• Then select Open Perspective  
• Select the Other option from the submenu 
• Window > Open Perspective > Other… 

Note: Version 4 users, instead of using the Window option on the menu bar, use the 
Perspective option 

Perspective > Open > Other    

A dialog similar to Figure 0-5 opens. 
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Figure 0-5: Select Perspective dialog 

• Select WebFacing from the list. 
• Click the OK push button.  

The workbench will now show the WebFacing perspective with the 
WebFacing Projects view open on the left hand side. You are ready to create 
a WebFacing project. 

Creating a WebFacing project 
In the workbench now:  

• Select the File option on the workbench menu bar to display the File menu. 
• Select the New option from the File menu,  
• Select WebFacing Project from the submenu. 

 
Figure 0-6: Menu structure to create a new WebFacing project 

This will start the WebFacing project wizard 

Completing the WebFacing Project page 
In the WebFacing project wizard you will be presented with the initial page 
On the WebFacing Project page: 
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Figure 0-7: WebFacing project wizard, first page 

• Type the project name wflabxx 
• Change the Enterprise Application project name  to wflabxxEAR 

This will create a unique Application file for this WebFacing project 
• Click the Next> push button. 

The J2EE Setting page opens. 

J2EE Setting 

Note: Version 4 users, the J2EE Settings page will not appear in your environment, 
skip to the Select display file source members to convert page. 

This page allows you to specify the J2EE level you want the WebFacing tool 
to use when creating the files for your WebFacing project. You might 
wonder what that means to you. If you plan to use the WebSphere 
Application Server version 5 only then I recommend you select J2EE level 
1.3, if you are using previous versions of WAS in you environment and are 
planning to deploy the WebFaced application to these versions then I 
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recommend to use J2EE level 1.2 since these older version of WAS don’t 
support the J2EE level 1.3. In this exercise you will use the WebFaced 
application in the WebSphere Test environment, which is version 5, so you 
will use J2EE level 1.3. 

 
Figure 0-8: Page to select JSP level 

• Click on the little arrow beside the J2EE level combination box 

• Select 1.3 from the list 

• Click the Next > push button 

The Select display file source members to convert page opens 
as shown in: Figure 0-9 

Selecting display file source members to convert  
On this second page of the WebFacing project wizard you need to specify 
the name of the iSeries server that contains your display file DDS source, as 
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well as wh ich members of the in the source file you want to convert. 
Specifically, the WebFacing Tool needs to know these names: 
Server name  
Library name 
Source file name 

Member name 

Tip: You need to identify members for all record formats used in your application. If 
you miss one and at runtime the record format gets requested, your end user 
will get a Page not found error 

First you need to specify the iSeries server name to specify 
where the Data Description Source (DDS) is located 

Creating a new connection in the Development Studio Client 
Since you are starting with a new workspace, you need to specify your 
connection information 

• Click the New push button (on the right side of the page beside the Connection 
combination box) as shown in Figure 0-9. 
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Figure 0-9: WebFacing project wizard, select DDS source members 

The New Personal Profile dialog opens as shown in figure 3-6:  

 
Figure 0-10:New personal profile 
 

• Accept the default profile name  
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• Click the Next > push button 
• On the Remote System Connection  page as shown in Figure 0-11 

 
Figure 0-11: New connection dialog, second page 

• Enter the Host name,  

Important: This is your iSeries server name; don’t use the one in Figure 0-11, unless 
your system is named S400A 

The connection name will be filled automatically with the same value 

Note: Version 4 users, key in your userid in the userid entry field, use the same that 
you used in the emulation session when you ran the Order Entry application 
first to familiarize yourself with the order entry application. During 
conversion this user id and when testing the application this user ID will be 
re-used. 

• Check the Verify host name check box 
• Click the Finish  push button. 

The connection gets created and can be re-used by all tools in the 
workbench. The connection wizard also checks whether the iSeries host can 
be reached and if this test is successful completed, you should be returning to 
the Select display file source members to convert page 

• Check that your iSeries server is selected in the Connection  combination box. 
• Make sure that *LIBL is selected in the Library filter combination box. 
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• Click the Refresh list push button. 
A user ID and password dialog opens, as shown in Figure 0-12 

 
Figure 0-12: Logon dialog to access iSeries server 

• Key in your User ID, use the same user ID that you used when running the 
Order Entry application in the beginning of this book. 

• Check the Permanently change user ID check box 
• Key in your password . 
• Check the Save password  check box 
• Click the OK push button on the Enter password  dialog  

A connection to the iSeries server gets established. The library list of your 
iSeries job is displayed in the tree view list on the WebFacing project wizard 
page: 

• Select the WFLABXX library from the list. 
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Figure 0-13: WebFacing project wizard, showing expanded library WFLABXX 

• Expand it by clicking the plus sign (+) beside the library name. 
• Select the QDDSSRC source file  from the expanded list. 
• Expand QDDSSRC, and select all members from the list. 
• Click the    >>    push button in the middle of the page to copy the selected 

members over to the list of members to be converted at the right. 

Note: To move all members in a source file you can select the source file icon itself 
and click the    >>    push button. This will add all members in a source file to 
the list of members to be converted 

• Click the Next> push button  at the bottom of the page to proceed to the next 
page of the wizard. 

The WebFacing Tool now knows which DDS members to convert for this 
project, the conversion hasn’t been done but the information is stored for 
future use 
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The Select UIM source members to convert page opens as shown in figure 3-
9 

 
Figure 0-14: WebFacing project wizard, select UIM source members 

Now you have to identify the panel group source containing the help 
information for the Order Entry application. 

• Click the Refresh UIM list push button 
• Expand library WFLABXX   
• Select the QPNLSRC source file  from the expanded list of library WFLABXX 
• Click the    >>    push button in the middle of the page to copy all members over 

to the list of members to be converted at the right. 
There is actually only one panel group member ORDENTRPNL in this 
source file 

• Click the Next> push button  at the bottom of the Select UIM source page, to 
proceed to the next page of the wizard. 

Completing the Specify CL commands page 
You will now provide the information that will allow the WebFacing wizard 
to create the initial index.html  page to start the Order Entry application. 
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Do you remember what you typed on the command line to start the Order 
Entry application in the 5250 emulation session during the first exercise in 
chapter two? 
In case you forgot; it was: CALL ORDENTR    
Why should you remember? 
The WebFacing run time needs to know the invocation command for your 
application in order to send this invocation command to the iSeries server to 
start your application from the browser. 
The page as shown in Figure 0-15 in the WebFacing project wizard will 
allow you to specify the necessary information. 

  
Figure 0-15:WebFacing project wizard, specify CL command and Sign on information page 

• Type CALL ORDENTR into the CL command entry field. 
•  Type Order Entry Application into the Command Label entry field 

Tip: If you don’t type anything into the command label field, the command label 
input will be copied into this entry field  
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• Select the Sign-on with specified values radio button.  
This will automatically apply the user ID and password you used when you 
connected to your iSeries server in the previous dialog for selecting source 
members for invocation of this application. You will use this setup here for 
testing purposes to make life easier for you when starting the Order Entry 
application without having to specify the authentication information. Don’t 
worry about security in your production environment, this can be easily 
changed later and I will show you how later in the book. 

• Click the Add push button on the right side of the page. 

Note: Make sure the text and command you typed into the entry fields 
are actually shown in the list at the bottom of the page. 

• Click the Next> push button at the bottom of the wizard page. 
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Choosing a web style 
On this wizard page, as shown in Figure 0-16, you can select a Web style for 
your converted screens.  

 
Figure 0-16:WebFacing project wizard, style selection page 

• Select the gradient style from the list of available styles. 
• Click the Next> push button. 

Completing the WebFacing Project information  
On this page shown in Figure 0-17 you have choice of creating 
the project and converting the source in one step or only 
creating the WebFacing project. At this point I want you to just 
create the WebFacing project. You don’t need to convert the 
source now. Conversion is part of the next exercise. 
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Figure 0-17:WebFacing project wizard, last page 

• Select the No, I only want to create the project now radio button. 
• Click the Finish push button. 

The WebFacing project is getting created, after a while the workbench will 
appear with the WebFacing perspective showing your new WebFacing 
project in the WebFacing Pro jects view as shown in Figure 0-18 
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Figure 0-18: WebFacing Project view with wflabxx project icon 

The WebFacing project environment 
Notice that the WebFacing project icon indicates which J2EE level will be 
used for the project. 
If you expand the wflabxx project you’ll notice a couple of nodes have been 
added to this WebFacing project: 

1. The information which display file source members should be converted,  
2. The information which panel group source members should be converted  
3. The CL Command that will be used to start the Order Entry application 
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4. The style to be used for the converted screens. 

 
Figure 0-19: Tree view of new WebFacing project 

When you expand the nodes in the tree view of your WebFacing project you 
can see the information that is captured for this project. 

• Expand the nodes by clicking on the + sign beside them 

Figure 0-19 shows the expanded WebFacing project tree view 

Tip: If you later need to add source members to the WebFacing project, right mouse 
click on the DDS or UIM help icon and select the Add menu option from the 
popup menu, this will launch the WebFacing wizard and display the correct 
dialog. 

You are now ready to convert and run your application. 

Analysis 
You completed Exercise: Creating a WebFacing Project.  
Here is what you did:   

• First you started Development Studio Client.  

• Next you launched the WebFacing project wizard.  
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• You then completed the pages of this wizard in order to create a new WebFacing 
project called wflabxx.  

• You added to this WebFacing project the following information:  

o Which DDS display file source members to use for the WebFacing 
conversion  

o Which UIM panel group source me mbers to convert  

o The CL command which will be used to create the initial index.html 
page to start the Order Entry application, 

o The Web style to be used for the resulting web pages  

• You inspected the WebFacing project, to verify that all information entered in 
the WebFacing project wizard has been captured  

You are ready to move on. Next you will convert and run your application. 
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 4 

CONVERTING SELECTED SOURCE MEMBERS 

The conversion creates the JSP files, XML files for record format layouts, and several other files 
needed for the Web application you are creating using the IBM WebFacing Tool. 

The Goal of the Exercise 
The goal of this  exercise is to practice the conversion of a WebFacing project in this case project 
wflabxx you created in the previous exercise (Exercise: Creating a WebFacing Tool Project). In the 
previous exercise you specified the complete information the WebFacing tool needs to successfully 
convert your application, now you‘ll do the conversion itself. 
On the WebFacing Project icon you will select the convert option, to start the conversion, and you’ll 
work with the conversion logs to check the results of the WebFacing conversion. 
At the end of this exercise, you should be able to:  

• Use the WebFacing Tool to select certain source members for conversion 

• Use the WebFacing Tool to start the conversion process 

• Analyze the conversion logs 

Scenario 
You have created a WebFacing project in the Development Studio Client, in this project you specified 
which display file source and panel group source to convert and which iSeries server these source 
members are located on. The WebFacing tool will use this information during the conversion process. 
You have to specify in this exercise whether you want to convert all source me mbers belonging to this 
project or selected ones only. 
A word regarding security, in case you are wondering, why you don’t have to logon to the iSeries server 
during conversion. Your user ID and password have been stored during the WebFacing project setup 
and will be re-used here. 

Converting iSeries source members to Web files 
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You will use Development Studio Client to do the WebFacing conversion, if it is not up and running 
already, start it now. If it is still up and running on your workstation you are ready to go ahead. 

Selecting the project and source members 
If the WebFacing perspective with your project is not visible you need to: 

• Open the WebFacing perspective. 

Tip: Check the side bar of the workbench for the WebFacing perspective icon and if you find it, click on the 
icon to switch to the WebFacing perspective that is already open but not active at the moment. Avoid 
having too many instances of the same perspective open. It will improve performance of the workbench 
if you restrict yourself to one instance of a perspective being open. We have seen situations with 50 
perspectives being open at the same time; this has caused severe performance impacts, so be careful. 

The picture as shown in Figure 0-1, depicts the icons on the sidebar of the workbench. In the picture the remote 
explorer perspective is active. The workbench window title bar shows this fact. 

.  

Figure 0-1: 0pen perspectives on workbench sidebar 

In Figure 0-1 I show the workbench with four perspectives open: 

1.  The WebFacing perspective 

2.  The Remote System Explorer perspective 

3.  The Java perspective 

4.  The Web perspective 

To switch to the WebFacing perspective, which is already open, select its icon  from the sidebar 

Tip: The icon  on top of the sidebar allows you to open a new perspective 

To start with the conversion, in the WebFacing perspective: 
• Select the WebFacing project you have been working on in the previous exercise, wflabxx. 
• Expand this project by clicking the plus sign (+) beside its icon in the WebFacing projects tree view. 

You should see a DDS folder in the expanded tree. 
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If you don’t see a DDS folder, you might be in the Navigator view and not in the WebFacing 
project view. 

  
Figure 0-2: Navigator view is active 

i Check that the view title bar is  not WebFacing projects  
ii Locate the WebFacing Projects tab at the bottom of the list pane, and click it. 

Now the WebFacing projects view should be active and you should be able to find the DDS folder. 
• Expand the DDS folder, so that you can see all three of the members that you selected in chapter 3: 

Creating a WebFacing Tool Project as shown in Figure 0-3. 

Starting the WebFacing conversion 
From here you can select individual members to convert or a collection of members. 
When you later in this book change only one source member you will select a single member to be 
converted. Since you want to convert all members in the project, you can actually work with the 
WebFacing project icon to convert DDS and Panel group members . 

• Right-click the wflabxx project icon. 
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Figure 0-3 WebFacing project ready to convert 

• Select Convert from the pop-up menu. 
The conversion process starts. This will take some time, be patient. 
You will see a progress dialog, indicating what members are being converted, as shown in Figure 0-4 

 
Figure 0-4 Conversion Progress dialog box  

Wait until the progress dialog disappears, indicating the WebFacing conversion has finished. 

Analyzing the conversion logs 
Notice the conversion log in the right pane as shown in Figure 0-5: 
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Figure 0-5 Conversion Log  

Checking the conversion log. 
At the bottom of the log are the following tabs: 

• Overview 
• Referenced Keywords 
• DSPF Conversion Log 
• UIM Help Conversion Log 

Click each tab to see more details about the conversion. You have now converted the DDS display file 
and panel group source. 

Analysis 
You did it, the DDS source and panel group  source is now available in a form a browser understands. 
The first important step to move you application to the web is done. Notice, the conversion itself was 
pretty easy, because you already did the hard part when you created the WebFacing project. Now that 
the project exists the WebFacing tool has all the information readily available and even having to re-
convert later because of changes in the original source is not a big problem. 
You have completed the exercise: CONVERTING SELECTED SOURCE MEMBERS  
Here is what you did: 

• You selected the WebFacing project to convert, all DDS source members and all panel group source 
members that are part of this WebFacing project. 

• You started the WebFacing conversion process. 
• You analyzed the conversion logs to ensure no errors have occurred during conversion. 

You are ready to move on. Next you will run your application with its new user interface. Proceed to 
the exercise: Running the Web-enabled application.
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5 
RUNNING THE WEB-ENABLED APPLICATION  

Introduction 
You are ready to test the WebFaced application. You normally would now 
have to copy all the files of your web project to a WebSphere Application 
Server (WAS) environment and then run your application there. Luckily there 
is a WebSphere Application Server imbedded in WebSphere Development 
Studio Client it is called the WAS test environment. Using the test 
environment makes the process of testing your WebFaced application a lot 
easier than testing in a remote WAS environment. Later on for your 
production environment you would copy all files needed to your production 
application server and I’ll tell you later on how to go thru this process for the 
various versions of WAS. In your real application development environment, 
you would test thoroughly in the test environment; then export the 
WebFacing project files to a remote WAS for final testing, before moving the 
Web-enabled application to your production WAS environment. 
Later exercises in this book show you the steps required to deploy to a 
remote WebSphere Application Server environment. Until you are sure your 
WebFaced application is ready for public use, you can use the test 
environment on your workstation, which simplifies testing tremendously. 
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The Goal of the Exercise 
The goal in this chapter is to practice testing your Web-enabled application 
in the WAS test environment. You will specify in the WebFacing perspective 
that you want to run your project in the Development Studio Client test 
environment. From the initial Web page, you will select the link created by 
the WebFacing Tool to invoke the WebFaced Order Entry application. 

 
At the end of this exercise, you should be able to: 

1. Setup the WebSphere Application Server test environment  

2. Run the Web application in the WebSphere Application Server test environment 

3. Select the link on the invocation Web page to invoke the RPG application 
4. Step through the Web-enabled application using the HTML-based user interface 

Scenario 
You have used the WebFacing tool to convert the user interface of the Order 
Entry application and you now want to see the conversion results. The 
WebFacing tool created a complete web application that can be run in an 
Application Server. The WAS test environment and the web project in the 
workbench are completely integrated and without publishing (copying) any 
of the files in the web project they are known to the WAS test environment. 
The index.html file that has been created by the WebFacing conversion 
routine is part of this web project. It will be used as the default page for this 
web application. 

When the application is up and running you will go thru the same 
scenarios as in chapter two when you went thru the green screen 
panels of the Order Entry application but now you are using the 
new WebFaced user interface. 

Showing the index.html page  
Follow these steps to show the index.html page for your web-enabled 
application.  

• Select your WebFacing project icon in the WebFacing perspective. 

• Right-click the wflabxx project folder.  
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Figure 0-1: Pop up menu for WebFacing project icon with run on server selected 

• Select Run on server from the pop-up menu. 

A server selection dialog comes up as shown in Figure 0-2 

 
Figure 0-2: Server selection dialog 

To avoid having this dialog come up every time you select run on server, 
• Select the check box Set server as project default (do not prompt) 
• Click on the OK push button 
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The WAS test environment gets started now, after a few moments the browser 
opens in the right pane of the workbench. Be patient; it takes time for the 
application server to start on your workstation. The minimum memory 
requirement for running the WAS test environment is 768 MB according to the 
IBM announcement letter for Development Studio Client Version 5. I have 
been running this WebFacing project successfully on systems with 256 MB. 
It will take more time for the application server to start  if you are working on 
a workstation that has less than the required memory. The system speed will 
also have an impact on the application server start up time. 
Eventually you will see the index.html page that has been generated by the 
IBM WebFacing Tool coming up in the workbench’s build-in browser.  

Note: Version 4 users: You will also notice the active perspective is now the Server 
perspective.  

Figure 0-3 shows the browser inside the workbench with the index.html page 
being displayed. 

 
Figure 0-3: Browser with index page 

Tip: To enlarge the browser window to the size of the workbench window, double 
click on the browser title bar. To get it back to its original size in the upper 
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right hand workbench view area, double click on the enlarged browser 
window t itle bar. 

Setting up the Test Environment for WAS version 4  
You have a choice of running WAS version 4 or version 5 in the workbench 
test environment. If you have followed my instruction and use Development 
Studio Client Version 5, you are using WAS Version 5 and the next sentence 
applies to you 
If you are using WAS Version 5 you can skip this topic and move on to 
heading: Running the Web application.  
If you have selected to use WAS Version 4, or are working with Development 
Studio Client Version 4, you will need to follow the steps under this topic to 
setup WAS correctly 
Before you can use the WAS Version 4 test environment for your WebFaced 
application you will need to change the default application server settings. 
The WebFacing applications have been generated with support for UTF-8. 
UTF-8 is a Unicode encoding that is used in WebFaced to be able to support 
green screens containing characters from any national language in the world. 
WAS version 4 is not using UTF-8 encoding by default; it has to be enabled 
for UTF-8 by changing its properties. The WAS property changes are 
performed by using the WAS administration console. This setup has to be 
done once for the server instance. In WAS Version 5 the encoding can be 
specified as a parameter value to in form the server what encoding is being 
used, for this reason you don’t have to specify the UTF-8 encoding when 
working with WAS version 5. 
If you are using WAS version 4 or version 3.5.6 on your remote server you 
will have to set up your remote WAS environment as well. The WebFacing 
help describes the steps for these environments in detail, so I will not go thru 
the remote server WAS setup in this book. 
If you are working with WAS version 4 

• Switch to the Navigator view by clicking on the Navigator tab in the WebFacing 
Projects view 
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Figure 0-4: WebFacing Projects view with Navigator tab highlighted 

• Expand the Servers folder in the Navigator view, as shown in: Figure 0-5 
 

 
Figure 0-5 Expanding the Servers folder 

• Double click on the defaultServer.wsi file 

Note: For Development Studio Client Version 4 users, this file has the name 
defaultInstance.wsi in your environment 

The WebSphere 4.0 Test Environment properties dialog is displayed, as 
shown in Figure 0-6 
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Figure 0-6 The WebSphere version 4 properties dialog  

• Click the Environment tab, the arrow in Figure 0-6 points to the tab. 
The Environment properties page will show as shown in Figure 0-7 

 
Figure 0-7: The environment properties page 

• Click the Add...  push button  
In the Add System Property dialog that appears, as shown in Figure 0-8 
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Figure 0-8 Add system properties dialog 

• Enter client.encoding.override  in the Name entry field 
• Enter UTF-8 in the Value entry field 

Tip: Make sure that you use the exact spelling and that upper and lower case 
characters are used exactly as shown. Using different case will cause 
problems later when you run the application. 

• Click the OK push button 
Back in the workbench 

 
Figure 0-9: Saving the changes  

• Select the Save icon on the toolbar or use the Fileà Save option on the menu 
bar to save the changes. 

In Development Studio Client version 5  
• Click on the Applications tab  
• Select Module in the WAR classloader policy combination box, as shown in 

figure 5-10 



WebFacing hands-on Lab                                                                       Page 63 of 220 

 CW                                                                                                  © Copyright IBM 
Corporation 2002 

Course material may not be reproduced in whole or in part 
without the prior consent of IBM 

•  
Figure 0-10: Changing the classloader policy to MODULE 

• Save this setting by clicking on the Save icon on the toolbar or select the File à 
Save option from the workbench menu bar. 

In Development Studio Client version 4 
• Expand the defaultConfiguration.wsc folder in the Navigator view under the 

Servers folder. 
• Double click on the server-cfg.xml  file. 

In the dialog that is coming up, as shown in Figure 0-11 

 
Figure 0-11 Module visibility 
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• Click on the down arrow button in the Module visibility combo box 
• Select Module from the select lis t in the combo box 
• Save this setting by clicking on the Save icon on the toolbar or select the File à 

Save option from the workbench menu bar. 

Continuing for both Development Studio Client 
Version 4 and 5 

Close the editor windows and browser windows that have been opened in the 
workbench. It is important to close the browser window so cached 
information is discarded. 

 
Figure 0-12 Closing the editor dialogs  

• Clicking on the X push buttons on the editors Windows Title bar, as shown in 
Figure 0-12. 

The application server is setup. To apply these changes to the server setting, 
you need to restart the application server. 
At the bottom of the workbench on the right side: 

•  
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Figure 0-13: The Servers page and the pop up menu for a server instance 

• Click on the Servers tab as indicated by the arrow in the Figure 0-13 
• Right mouse click on the Server instance in the Servers list as shown in Figure 

0-14 

•  
Figure 0-14: Popup menu for application server 

• Select Restart from the pop up menu 
After the Console view displays a message that the server is open for e-
business you can go back to the WebFacing perspective to the browser view 
in the workbench. 

Running the Web application 
In the browser window as shown in Figure 0-3 you will see two links for the 
Order Entry application because the IBM WebFacing Tool creates two links 
automatically.  

1. The top link will invoke a complete browser window with all the toolbars and 
buttons available. 

2. The second link starts a new browser session for the application. This new 
browser session displays just the window frame, but none of the browser menus 
or toolbars are visible. This second link was added because many WebFacing 
users felt the normal browser window could overwhelm some end users and 
offer too many capabilities like the Back  button on the toolbar. 

• In your browser pane, click the top Order Entry Application link. 

Tip: For Development Studio Client Version 4 users, you have to click twice on the 
link. The first click will give the browser focus; the second click will actually 
send the click event. 
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After a few moments the first application page will appear in the browser, as 
shown in Figure 0-15. 
 If you find the response time a bit slow, keep in mind that the first time the 
JSP file is requested, it has to be compiled into a servlet at first touch. If you 
run the application a second time, you will see improved performance since 
the servlet already exists. This is normal application server behavior.  
Now I want you to go thru the same steps as in chapter 2: Reviewing our 
5250 application, to review the results of the WebFacing conversion. This 

will give you a sense how the default conversion will change your original 
application. You will then have a chance to improve the conversion results. 
The one area that you can’t test in the built in browser, is the Help support, 
you will have to start the application from an external browser, I will show 
you how to do this at the end of this chapter. If you press the F1 key in the 
internal browser you will get an error message as shown in Figure 0-16 .  

 
Figure 0-15 First application page in browser window 
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Figure 0-16: Help panel error message in built in workbench browser  

• Click the Prompt push button, or press command key four, to get the selection 
list window. 
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•  
Figure 0-17: Customer selection list 

• Select a customer from the subfile. 
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•  

Figure 0-18: Order entry screen with customer details 

Back on the Order Entry screen 
• Click the Prompt push button, or press command key four to display the parts 

selection list 
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•  

Figure 0-19: Parts selection list 

• Select a part  

• Press the Enter key  
Back on the Order Entry screen 
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Figure 0-20: Order entry screen with quantity specified 

• Enter a quantity 
• Press the Enter key  

Continue ordering one or two more parts  
Press command key F6 to accept the order 

The application works the same way as before in a 5250 environment it just got a 
browser user interface. 

Testing the help support 
As I mentioned before, the help support will only work when you run the 
application in an outside browser.  Start Internet Explorer on your desktop 
and key in the following URL: 
http://localhost:9080/wflabxx/ 
You could also copy it from the internal browser URL field and paste it in 
here. 
Internet Explorer will show the index.html page as shown in  
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Figure 0-21: Internet Explorer with index.html page for wflabxx 

• Click the first link on this page 

The application will come up in the browser, to get help: 
• Press the F1 key 

Another browser window comes up with the 
help information as shown as in figure  
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Figure 0-22: Help panel in browser 

Now try the links: 
1. Select 

2. Enter number 
3. Extended help 

Your UIM based help panels are all available in the WebFaced application. 
Close the help browser window and press F3 to end the application 
  

    
Analysis 

You have completed Exercise: Running the Web-enabled application. 
Here is what you did: First you set up the WAS Test Environment. Then you 
started the application in the WAS Test Environment. Next you selected a link 
on the index.html page to start the Web-enabled application. Finally, you 
used the Web-enabled application as you did in Exercise: Reviewing our 
5250 application. 
You are ready to move on. Next you will improve the look of your 
application. In the next exercise I will guide you through some customization 
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steps to enhance the pages of your Web-enabled application. Proceed to the 
next exercise: Changing the User Interface.
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 6 
Changing the user interface 

 

Introduction 
To enhance the results of the WebFacing Tool, IBM has added a new 
function to the CODE Designer tool, called Web Settings. CODE Designer is 
the GUI-based screen design tool for 5250 panels. It allows you to change 
certain aspects of the user interface related to the WebFacing conversion 
process. CODE Designer stores the Web Setting information as comment 
lines in the DDS source. When you convert the application using the IBM 
WebFacing Tool, these DDS source comment lines are picked up and applied 
to the new user interface.  

 

Tip: You cannot use Screen Design Aid SDA on DDS source members that have Web 
Settings applied. This restriction had to be imposed because SDA will change 
the location of comment lines or delete comment lines, which would 
invalidate the WebFacing Web Settings  



WebFacing hands-on Lab                                                                       Page 76 of 220 

 CW                                                                                                  © Copyright IBM 
Corporation 2002 

Course material may not be reproduced in whole or in part 
without the prior consent of IBM 

The Goal of the Exercise 
The goal of this exercise is to practice changing the user interface of your 
Web-enabled application with CODE Designer. In the WebFacing perspective 
you will select a DDS source member to work with; start CODE Designer to 
open this DDS member; work with Web settings in CODE Designer to change 
the web look, and then reconvert the DDS member. 
At the end of this exercise, you should be able to:  

• Access DDS source fro m within the WebFacing perspective using CODE Designer 
• Change the web user interface with Web settings 
• Reconvert the changed DDS display file source member 
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Scenario 
You want to improve the user interface that got generated by the WebFacing 
tool. In particular, you want to improve the customer selection subfile. At the 
moment the web user interface for selecting a record from this subfile does 
not have the web behavior you would like it to have. It requires to key in a 1 
into the options column to select a record, this mimics exactly how the green 
screen has worked in the past. You would like it to behave more like a web 
user interface where you select by clicking on a link.  
I will guide you thru using the Web Setting capabilities in CODE designer to 
make the necessary modifications. 
You will change the second column in the customer selection subfile, which 
contains the customer name , from a simple text output field to a link. When 
the end user clicks on this new customer name link, magic will happen and 
the correct information your program expects is sent. You might ask what is 
the correct information? What is your program expecting? It is expecting a 1 
in the subfile options field for the selected customer record. It will exactly 
get the same information after you changed the user interface. The 
WebFacing conversion will add logic to the user interface, so that the 
options field gets filled with a 1 and the Enter key event is invoked when the 
link is pressed. 
You enhance the user interface and don’t have to change the application, this 
sounds pretty impressive doesn’t it. 
Lets start and see what Web Settings in CODE Designer can do for you. 

 Accessing DDS display file source 
Since you will use the WebFacing perspective to invoke CODE designer you 
start this exercise using Development Studio Client in the WebFacing 
perspective. 

• Start WebSphere Development Studio Client and open the WebFacing 
perspective, if it is not up and running already. 

In the WebFacing perspective, make sure that you are in the WebFacing 
Projects view and not the Navigator view. 
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• Expand your project in the tree view by clicking on the plus sign (+) beside the 
WebFacing project icon. 

•   
Figure 0-1:Pop up menu for DDS source member 

Start CODE Designer with the following steps: 
• Expand the DDS folder. 
• Right-click the SLTCUSTD source member inside the DDS folder.  
• Select Open With >?CODE Designer from the pop-up menu. 

Figure 0-1 shows the menu structure 
CODE Designer loads the DDS member. 
This takes a moment. 
The DDS member loaded in CODE Designer opens: 
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Figure 0-2 CODE Designer select group Screen1 

• Select the SCREEN1 tab on the notebook. 
The arrow in Figure 0-2, points to the tab. 
You should now see a dialog similar to Figure 0-3  

  
Figure 0-3 CODE Designer 
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As you see, you are working with the green screen image in CODE Designer. Do you 
recognize the screen? It is the customer selection list. This is the screen I want you to 
change, so it will appear more web-like to the end user after it has been WebFaced. 

• Click the second column of the first row in the subfile (the customer name  field) 
as shown in Figure 0-4 

 
Figure 0-4 Selecting the subfile second column 

Applying Web settings 
Now work with the Notebook underneath the design window, locate the Web 
Settings tab as shown in Figure 0-4 

• Select the Web Settings tab by clicking on it. 
The Web Settings page in the CODE Designer window should look similar 
to Error! Reference source not found. 



WebFacing hands-on Lab                                                                       Page 81 of 220 

 CW                                                                                                  © Copyright IBM 
Corporation 2002 

Course material may not be reproduced in whole or in part 
without the prior consent of IBM 

 
Figure 0-5 Create hyperlink page 

• On the Web Settings page, locate the list that shows the different Web settings 
available for the customer field,  

If not all Web Settings show.  
• Scroll down to the bottom of the list, and select Create hyperlink . 
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Figure 0-6: Web Settings for Hyperlink  

• Check the Create hyperlink  check box to the right of the list. 
• Select the Action hyperlink  radio button 
• Select the Position cursor to Field  check box 
• From the Combination box underneath, select the &{OPT} value 
• In the Enter data combination box, enter 1  

This indicates that you want a one to be entered in the options field 
when the hyperlink is clicked on. 

• Select the Submit check box. 



WebFacing hands-on Lab                                                                       Page 83 of 220 

 CW                                                                                                  © Copyright IBM 
Corporation 2002 

Course material may not be reproduced in whole or in part 
without the prior consent of IBM 

• Select the Function key radio button 
• Select Enter from the Function key combination box. 

Just to recap, you specified the following, when the application gets 
converted with the WebFacing Tool:  
The customer name  cells in the subfile will be generated so they appear as 
links in the browser window. 
At run time, when the link  is clicked, a 1 will be placed in the option field. 
Also, a submit request will be initiated to generate the equivalent of pressing 
the Enter key.  
The basic task I wanted you to accomplish is done, but the user interface 
now has an option column that doesn’t belong there since it is useless with 
the new link. Also the instructions on the page how to select a customer are 
wrong. I want you to fix this with Web Settings as well before you test this 
new feature 

Hiding the Option column 
On the design pane, you now need to select the option field to indicate that 
you want to work with it.  

• Click the Opt column  on the first record in the subfile to select it. 
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Figure 0-7 Web Settings visibility page 

On the Web Settings page, 
•  Click Visibility in the Web Settings list box.  
• Select the Hide field radio button. 

Now this column in the subfile will be hidden. 

Hiding the Option heading 
You need to hide the heading for the option field as well. The heading is not 
in the subfile record it is located in the subfile control record. Therefore you 
need to give focus to a different record format in the design screen.  
You might think what is he talking about, this looks like one record format 
and how did I get two record formats into this view. Lets look at some of the 
CODE Designer features. Normally in the iSeries green screen world, your 
screens are made up out of multiple record formats that at runtime get 
assembled by the RPG or COBOL program to present the real screen your end 
user sees. To make it easier for you at design time to get a feel how the 
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record formats you create would look like at runtime, CODE designer has 
added the notion of a group. You can assemble several record formats in a 
group this feature gives you the capability of mimicking what happens at 
runtime with your record formats. So a group resembles the runtime 
grouping of record formats for you at development time. 
In the sample you are working with, I have already assembled three record 
formats into group SCREEN1. The record formats: 

• CUSTSFL 

• CUSTCTL 
• SLTCUST 

To get a list of record formats belonging to a group you can expand the 
combo box on top of the design window as shown in Figure 0-8 

 
Figure 0-8: Group SCREEN 1 and list of record formats  

Only one record format in a group is active at a time. The record format 
name is listed in the top field of the combo box. Also in the design window 
all parts in the active record format are shown in regular density but the 
inactive record format content is dimmed. You see this effect very clear in 
Figure 0-8 
Until now you have been working with the subfile record format CUSTSFL 
only, but now you need to clean up the subfile control record format 
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CUSTCTL, so you need to make it the active record format or another way to 
describe this, give it focus. 
To shift focus to another record format:  

• At the top of the design pane, click the arrow, as shown in Figure 0-9 
 

 
Figure 0-9 CODE Designer switching record formats in a group 

You will notice that the top area of the design window is now highlighted, 
and the bottom one has only half intensity. As mentioned before the 
highlighted area is the one you can work with. Figure 0-10 shows the subfile 
control record being in focus. Follow the next steps to clean up the subfile 
control record format. 
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Figure 0-10: Subfile control record format in focus  

• On the design pane, select the OPT Customer constant. 
• On the Web Settings page, select Appearance and Text from the list box. 
• Select the Hide characters check box. 
• Specify 1 in the From field. 
• Specify 3 in the To field. 

This hides the heading Opt, now you need to get rid of the instructions on the 
panel that guide the user to put a 1 into the option field to select a specific 
customer. 

Hiding the Select instruction 
You don’t have to give focus to a different record format since this constant 
is also located on the ORDCTL record format. 
On the design page in CODE Designer: 

• Select the constant 1=Select in the design area. 
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Figure 0-11: Use Visibility Web Setting to hide constant 

On the Web Settings page: 
• Select Visibility from the list box. 
• Select the Hide field radio button. 

Changing the instruction (Type choice press Enter) 
Now you need to add new instructions for the WebFaced page, so the end 
user knows he/she has to click the link to select a customer. Note you can’t 
just change the 5250 constant because you might still use this screen in a 
5250 environment, you have to use web Settings to apply this change to the 
web user interface only. Change the instruction text with the following steps: 

• Select the instruction constant (Type choices press Enter) on the design page, as 
shown in Figure 0-12 
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Figure 0-12 Changing the instructions with Web Settings  

Then on the Web Settings page, 
a. Select Appearance and Text from the list box, 
b. Select the Override constant text check box, and type the new text in 

the field to the right of the check box: Click on link to select  
Now all Web Settings are in place and you can go ahead and save the DDS 
source and reconvert this DDS member. 
Closing CODE Designer and re-converting the DDS member   

• Click the x button at the top right corner of the CODE Designer dialog. 
• Specify Yes to save, when asked to do so. 

You are done with CODE Designer. 

• Go back to the WebFacing perspective in the Development Studio Client 
workbench. 

• Select your project wflabxx in the WebFacing view. 
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• Expand the project by clicking on the plus sign (+) in front of its icon, if you 
can’t see the DDS folder as part of the project. 

• Expand the DDS folder, if it is not expanded already, to show all members in 
this folder. 

 
Figure 0-13: WebFacing Project view, popup menu for DDS source member 

• Select the member SLTCUSTD that you just changed. 
• Right-click the SLTCUSTD member icon. 
• Select Convert from the pop-up menu.  

Only this member will be converted. A conversion report will show up after 
the conversion is finished. Now test the new user interface. 

Running the Web application 
Let's see the new user interface in your application: 

• Right-click the project icon in the WebFacing projects list. 
• Select Run on Server from the pop-up menu. 
• Go to the browser pane and click the Order Entry Application  link. 

You will see the first screen of your application, nothing has changed there. 
• Click the Prompt push button, or press command key four. 
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Figure 0-14: Customer selection window with links 

The customer selection window appears and the customer fields are shown 
as links. Also notice the changed text and the non-visible option column. 

• Select a customer from the list by clicking on the link. 
• Go through the same steps as in Exercise 1: Reviewing our 5250 application, 

and try it out. 

Analysis 
You have completed the exercise: Changing the User Interface. Here is what 
you did: First you used CODE Designer to access a DDS source member. You 
used Web Settings in CODE Designer to change the web user interface. Next 
you reconverted the changed DDS.  
Note that your green screen user interface has not changed if the application 
is invoked as a green screen application it will look like the original user 
interface. The Web Settings apply only to the WebFaced user interface. 
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You are ready to move on. You have improved the look of your application, 
however, there are more improvements to be made. In the next exercise I 
will guide you through some more customization steps to further enhance the 
pages of your Web application. Proceed to the next exercise: Changing the 
style of the Web Interface.

 7 

CHANGING THE STYLE OF THE WEB USER INTERFACE 
 Introduction 

You will change the user Interface of your Web-enabled application by using the WebFacing style 
properties dialog. The style changes are applied on a project level; so all pages in a project will be 
displayed with these changes applied. In this exe rcise we want you to change the text color and font for 
all highlighted fields. Also you will learn how to locate the .css file where these changes have been 
stored. 

 

The Goal of the Exercise 
The goal of this exercise is to practice changing a style to tailor the Web interface to your needs.  
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You will start the Style Properties dialog, create a new style, change style settings, specify the new style 
to be used for this project, and refresh the project with the new style. 

 
At the end of this exercise, you should be able to: 

• Create a new style using the WebFacing Style Properties dialog 
• Use the field -level properties pages to change the look of your Web pages 
• Change the project to use a different style  

Scenario 
You don’t like the way the WebFacing tool is mapping some of the display attributes to colors and text 
styles available in the browser. You want to change the default WebFacing style rules that govern how 
certain 5250 parts are displayed in a browser to give the web user interface a better look. In this chapter 
you will learn how to change the style rules for highlighted fields. 

Invoking the Style Properties dialog 
During this exercise you will use the Style Properties dialog in the IBM WebFacing Tool to tailor your 
Web user interface. You will change the rules for highlighted fields in the 5250 panels so they appear 
more visible in the Web user interface. The style for highlighted fields will be altered so at runtime the 
text font will be different and a larger font size will be applied. 

• Start the workbench of WebSphere Development Studio Client and open the WebFacing perspective, if it is 
not up and running already. 

 
Figure 0-1: WebFacing project with pop-up menu 

• Right-click the wflabxx project. 
• Select Properties from the pop-up menu. 
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The WebFacing project properties dialog opens, as shown in Figure 0-2 

 
Figure 0-2 WebFacing project properties  

 
• Under Style in the tree view at the left side of the dialog, click DDS field display attributes, as indicated by 

Figure 0-2 

The DDS field display attributes page opens on the right side of the dialog as shown in Figure 0-3. 

 
Figure 0-3 DDS field display properties  

• Click the  push button to the right of the High intensity combination box. 
The Font dialog opens as shown in Figure 0-4 
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Figure 0-4: Font dialog 

• In the Font box, select Comic sans MS 
• In the Font style box, select Bold 
• In the Size box, select 16. 

Tip: Don’t try to change the color in this dialog, the color setting doesn’t work, later in this chapter I’ll show 
you how to change the color.  

This changes the font size and appearance for parts that have the high intensity attribute active. 
• On the properties page, click the OK  push button. 
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Running the Web application 
Let's check the new style in your application: 

• Right-click the project icon in the WebFacing projects list. 
• Select Run on Server from the pop-up menu. 
• Go to the browser pane and click on the Order Entry link. 

You will see the first screen of your application. Notice the different font and font size of some of the 
text; these are the highlighted areas of your 5250 screen. 
Prompt for the customer. The customer selection screen has highlighted text and this text should show 
in Font Comic sans serif and size 16 as shown in Figure 0-5. 

Tip: If the text is still showing the old fonts, most likely the browser has cached the page and you need to close 
the browser window, and restart the application, that will bring up a new instance of the browser without 
cached content. 

 
Figure 0-5: New highlight attribute mapping and non-CUA command key description 

Since the Font dialog has a bug that makes it impossible to change Font colors in this dialog, I show 
you next how to directly change WebFacing style classes. 

Changing styles directly 
Instead of working with properties in the WebFacing project you can also change the styles being 
applied direct in the Cascading Style Sheet (.css) file that WebFacing uses. In this  section part, I’ll 
explain where this file is located at in the WebFacing Project structure and how to find your way around 
in this file. In Chapter 17 Web Settings I explain how to create your own style sheet classes and use 
them in a WebFaced user interface.  

Locating the Cascading Style Sheet file 
In the WebFacing perspective switch to the Navigator view by: 
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Figure 0-6: The Navigator tab in the WebFacing perspective 

• Clicking on the Navigator tab as shown in Figure 0-6 
In the Navigator view: 

 
Figure 0-7: Navigator view with apparea.css file 

• Locate the apparea.css file in the WebFacing project as shown in Figure 0-7 
It is located in the following directory hierarchy: 
wflabxx\Web Content\styles\apparea\ 

Tip: For Version 4 users: The directory structure is slightly different: wflabxx\webApplication\styles\apparea\ 

• Double click on the apparea.css file icon in the tree view, to open an editor for this file 

Changing the WebFacing highlighted style class 
The editor dialog will come up and show the style source 

• Scroll down the source file until you reach the .wf-hi class as shown in Figure 0-7 
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Figure 0-8: Editor dialog with apparea.css source located at the wf_hi class 

You’ll notice your changes from the previous exercise being applied here. The WebFacing tool has 
created style sheet classes for the different 5250 parts and attribute combinations and stored them here. 
Each of the lines starting with a dot is containing a style class name. The statements inside the curly 
brackets after the style class name describe the attributes of the class itself. For this WebFacing .css file, 
the name of the classes are self describing, for example .wf_hi defines how a part that has the 
highlighted attribute active gets displayed in the browser, wf_cs describes the column separator, etc. 
You can go in and change the dis play characteristics for any of the 5250 attributes. 
For example to change the color attribute of the highlighted  class go thru the following steps: 

• Position the cursor at the end of the last line of the wf_hi class before the ending curly (}) bracket, as 
shown in Figure 0-8 

• Press the Enter key to insert a line 

 
Figure 0-9: Highlighted class color changed 

• Insert the color attribute you want to use, for example: 
color: #ff9999; as shown in Figure 0-9  

Tip: Don’t forget the semicolon to delimit the line 
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• Save the change by clicking the save button in the workbench  

For version 5 users, there is a nice feature available in the Style sheet editor that allow you to look at the changes 
you have made to a class directly in the editor without actually invoking the page and showing in a browser. 

Look at the right side of the workbench beside the editor as shown in Figure 0-10 

 

Figure 0-10: Style change example in Style sheet editor 

If you asking yourself how to figure out what color is represented by the hex code ffff99, there is an 
easy way to find out. 
Look into the area underneath the editor in the workbench as shown in Figure 0-11 

 
Figure 0-11: Color tab example 

• Select a color from the color palette 

The corresponding hex number will appear in the dialog as shown in Figure 0-11 

Tip: Instead of a hex number you could use a color name like yellow to set a color for a style class  
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To have a look at the changed user interface, run the application again. 

Running the Web application 
First close the style sheet editor and close the browser if they are still open. 

• Click on the X in the Window bar of any editors or views still open at the right upper hand side of the 
workbench to close them all. 

Let's check the new style attribute in your application: 
• Right-click the project icon in the WebFacing projects list or Navigator in the WebFacing perspective. 
• Select Run on Server from the pop-up menu. 
• Go to the browser pane and click on the Order Entry link. 

You will see the first screen of your application. Notice the different color of the text in the highlighted 
areas of your 5250 screen. 
Prompt for the customer. The customer selection screen will show the same changed attribute, 
remember style changes are getting applied to all application as shown in Figure 0-12. 

Tip: If the text is still showing the old colors, most likely the browser has cached the page and you need to close 
the browser window, and restart the application, that will bring up a new instance of the browser without 
cached content. 

 
Figure 0-12: New color attribute applied to highlighted style class 

You might not have noticed it before, but there is still a command key description  at the bottom of the 
customer selection window as shown in the circle in Figure 0-12. 
 You might have guessed it; you will fix this in the next exercise 

Analysis 
You have completed exercise: Changing the Style of the Web User Interface.  



WebFacing hands-on Lab                                                                       Page 101 of 220 

CW                                                                   © Copyright IBM Corporation 2002 
Course material may not be reproduced in whole or in part 

without the prior consent of IBM 

First you used the WebFacing properties dialog to change the style for WebFaced highlighted fields. 
You applied a new font style and a bigger font size. You tested these changes and made sure they got 
applied to all screens. You also notice that the changes got applied without a re-conversion of the DDS 
source. Style changes  are directly applied at runtime and don’t require re -conversion.  
You then edited the Cascading Style Sheet file directly with the style sheet editor, to change the color 
attribute of the WebFacing highlighted  style class. You saved your changes and tested the application to 
make sure these changes would appear on the application screens. 
You are ready to move on the next exercise, you improved the Web User Interface, now you are going 
to enhance the way command key labels are being handled by the WebFacing tool. 
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 8 

ADDING COMMAND KEY RULES AND LABELS 
  

Introduction 
You might have noticed that most command key descriptions that are placed 
at the bottom of the original panels in the sample Order Entry Application 
have been removed from the WebFaced user interface. The removal happens 
automatically if the command key descriptions follow the Common User 
interface Access (CUA) rules (for exa mple, F3=Exit). If they don’t follow 
these rules you can supply the WebFacing Tool with the command key 
description rules you use in your user interface, and the WebFacing Tool 
will apply these rules to recognize your specific command key descriptions. 
As I pointed out at the end of the last exercise, one of the record formats in 
the sample application contains a command key description that doesn’t 
follow the CUA rules. You will use the WebFacing conversion properties 
dialogs to add your own command key description rule. 
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Also in your user interface you might have enabled command keys without 
describing them in the user interface because they are only used for specific 
functions and your end user knows how they work. For example command 
key three for ending an application or command key 12 for canceling a task 
are well known to be enabled for these tasks. So your user interface might 
not list them explicit at the bottom of the panel. 
The problem with this kind of user interface design, the WebFacing tool 
doesn’t have a string it can put in the label of the push buttons on the web 
page. It will just put for exa mple CA12 for an active command key 12 in the 
push button label. However there is a way out, the WebFacing tool allows to 
specify labels for these common command keys so it can label the command 
key push buttons correctly. You just have to the WebFacing tool in its 
conversion properties what the label is. 

The Goal of the Exercise 
The goal of this exercise is to practice adding your own command key 
recognition rules to the WebFacing conversion properties. You will also add 
command key labels, for command keys that have missing labels in the DDS 
source. You will use the WebFacing Conversion Properties dialogs, work 
with command key recognition patterns, and work with command key labels 
to fix the deficiencies in the WebFaced user interface. You will reconvert the 
user interface with the new WebFacing conversion properties being applied. 
At the end of this exercise, you should be able to add non-CUA command key 
prefixes to the conversion recognition patterns and add commonly used 
command key labels to the WebFacing conversion properties. 

Scenario 
In the sample Order Entry application exists one screens that doesn’t follow 
the CUA rules for command keys descriptions, as I pointed out in the last 
exercise it is the customer selection list window. The WebFacing tool will by 
default not recognize these command key descriptions and will not delete 
them.  
The Order Entry main screen has a command key enabled that has no 
description associated with it. The WebFacing tool by default can’t handle 
this situation and puts a default string in the push button label representing 
this command key. 
In this exe rcise, you learn how to enable the WebFacing tool to deal with 
these common green screen environments. 

Working with command key description patterns 
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The prefix for the command key description in the SLTCUST  record format is: 
Fkey= as shown in Figure 0-1 

 
Figure 0-1: Function key description on Customer selection panel 

This doesn’t follow the CUA rules normally used in iSeries user interfaces, so 
the WebFacing conversion does not recognize this pattern and does not hide 
it. 
You have to add this prefix pattern to the WebFacing Tool conversion rules 
in the WebFacing Properties dialog. 
In the WebFacing perspective in the WebFacing project view: 

 
Figure 0-2 Pop up menu for WebFacing project 

• Right-click your WebFacing project icon wflabxx. 
• Select the Properties option from the pop-up menu as shown in Figure 0-2. 

The Properties for wflabxx dialog opens as shown in Figure 0-3. In the left 
hand list of this dialog: 
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Figure 0-3: WebFacing Properties dialog. 

• Select the Command key recognition patterns node. 
The right hand pane will switch to the associated dialog, as shown in Figure 
0-4, in the Command key recognition patterns dialog 

 
Figure 0-4 Command key recognition patterns dialog 

• In the Prefix combination box, enter Fkey 
• In the Separator combination box, enter = 
• Click the Add push button to the right of these two combination boxes. 

The additional rule is now part of this style. 

Tip: The default conversion action is, to remove the text from the bottom of the 
panel. You can change this by selecting a different action using the three 
radio buttons at the bottom of the dialog. 
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• Click the OK push button. 
Next, you will test this feature by converting the DDS member and running 
the application 

Converting the application 
Since these are conversion properties you are changing and not style 
properties as in the previous exercise, you will need to reconvert all member 
that contain command key descriptions with this pattern. In the sample 
Order Entry application this is only member SLTCUSTD. 
In the Studio Client workbench, in the WebFacing Project view: 

• Expand the wflabxx project. 
• Expand the DDS folder. 
• Right-click the SLTCUSTD member icon. 
• Select the Convert option from the pop-up menu. 

After the conversion, take a look at the change. 

Running the Web application 
Let's see how the new rule is applied to your Web-enabled application. 

• Right-click the project icon in the WebFacing projects list. 
• Select Run on Server from the pop-up menu. 
• Go to the browser pane and click the Order Entry link. 

You will see the first screen of the sample application. 
• Click Prompt or press F4. 

The customer selection list window opens as shown in Figure 0-5. 
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Figure 0-5: Customer selection window without command key label  

Notice that the command key text Fkey12=Cancel is gone from the bottom 
of the window as shown in Figure 0-5.  
>>>>>>>>>>>>>>might add the Pushbutton add instead of removing the 
text if this works 

• Select a customer or cancel by pressing F12 to get back to the applications main 
panel as shown in Figure 0-6 

Now that you know how to change the command key recognition patterns in 
WebFacing tool, I go thru a slightly different scenario in the next section. As 
mentioned in the beginning I want to show, how you can add text to 
frequently used command keys that don’t have a text description in the DDS 
source. 
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Figure 0-6: Missing label for command key CA12 

Back on the Order Entry panel, you can see that the push button for F12 
does not have a description. Its label shows CA12. You will learn how to fix 
the label in the next section of this exercise. 

Adding Command key button labels  
The WebFacing tool allows you to specify command key descriptions for 
command keys that are commonly used in your application but not described 
in your DDS source and on your screens. This way the push button labels on 
the web pages can automatically be changed during conversion to the correct 
text. 
You will add the description Cancel to the WebFacing conversion properties 
so the push button will get created to show a Cancel label instead of CA12. 
In the Development Studio Client workbench, in the WebFacing project list: 

• Right-click your WebFacing project icon. 
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Figure 0-7: The properties menu option for the WebFacing project 

• Select Properties from the pop-up menu. 
The Properties for wflabxx dialog opens. 
In the list, at the left of this dialog as shown in Figure 0-8 

• Select Conversion > Command key button labels 
This opens a dialog on the right side of the properties dialog. 
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Figure 0-8: Command key button labels 

• In the Command key combination box, select F12. 
• In the Button label combination box, select Cancel. 
• Click Add to the right of these two combination boxes. 

The additional label is now part of the WebFacing conversion properties for 
this WebFacing project. 

• Click the OK push button at the bottom of the properties dialog 
Next, back in the Development Studio Client workbench, test this feature. 

Converting the application 
Convert the application in the workbench: 

• Expand the wflabxx project. 
• Expand the DDS folder. 
• Right-click the ORDENTD  member icon. 
• Select Convert from the pop-up menu. 

After the conversion, take a look at the change. 
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Running the Web application 
Let's see the new label for the F12 push button in your Web-enabled 
application. 

• Right-click the wflabxx project icon in the WebFacing projects list. 
• Select Run on Server from the pop-up menu. 

 
Figure 0-9: Pushbutton with fixed label 

• Go to the browser pane and click on the Order Entry link.  
• Check that the Cancel push button on the first page now shows the correct label 

as shown in Figure 0-9. 

Analysis 
You have completed Exercise: Adding Command key rules and labels. Here 
is what you did: 
First you started the WebFacing Project Properties dialog. Next you used the 
command key recognition properties page to change the Fkey12 command 
key recognition pattern for the command key label on the customer selection 
window. You then used the command key button labels properties page to 
change the undefined F12 command key label. Finally, you reconverted the 
application and then ran the application and checked the changes. 
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You are ready to move on. Next you will continue to enhance the style of the 
Web-enabled application. 
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WORKING WITH MORE STYLE PROPERTIES  

In this exercise you will change the user interface even more and hopefully 
make it more usable in a web environment. You will use the WebFacing tool 
Style Properties dialog that you already used in Chapter 7. Since a style is 
used on a project level, all web pages in your project will contain the 
changes you apply to a particular style. Specifically you will learn how to 
apply changes to windows, the look of push buttons, and subfiles. 

 

The Goal of the Exercise 
The goal of this exercise is to practice changing the user interface further, 
using style properties. You will work with Style settings and check the 
changes by refreshing the style and running the application. 
At the end of this exercise, you should be able to:  

• Work with the additional pages of the Style Properties dialog 
• Work with the window properties page  
• Work with the scrollbar/subfile properties page 
• Work with the command key look properties page 
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Scenario 
Now that you gotten the web user interface changed so the green look 
doesn’t show thru as much as after the straight WebFacing conversion, you 
want to add some more refinements to the appearance of your web pages. I 
will show you how you can do this with the WebFacing tool Style properties.  

Start the WebFacing Style Properties dialog 

First, you will use the WebFacing Style properties dialog to tailor your Web 
user interface.  
You will apply changes to the window layout of your screens, the subfile 
appearance will be changed, and you will enhance the command key 
pushbutton looks.  

• Start the WebSphere Studio workbench and open the WebFacing perspective, if 
it is not up and running already. 

• In the WebFacing project view, select the wflabxx project. 
• Right-click the project icon, and select Properties from the pop-up menu. 

The project properties dialog opens as shown in Figure 0-1. 
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Figure 0-1: The WebFacing project properties dialog 

• Under Style in the tree view at the left side of the dialog, select Window. 
The Window Properties page opens on the right pane of the dialog as shown 
in Figure 0-2. 
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Figure 0-2: Windows properties page 

• Select Title in the combination box at the top of the page.  
In the Foreground group box:  

• Click the  push button to the right of the Color combination box. 
• On the color selection dialog, click Yellow, 
• Then click the OK  push button in the color selection dialog. 

On the window properties page: 

• Click the  push button to the right of the Font combination box. 
• Select Font Comic sans MS, size 16. 
• Click the OK push button on the Font selection dialog 

• In the Background group box, click the  push button to the right of the Color 
combination box. 

• On the color selection dialog, click Green 
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• Click the OK push button on the color selection box. 
Back in the windows properties dialog,  

• Select Body in the combination box at the top of the page. 

 
Figure 0-3: Window properties dialog with "Body" selection 

 
In the Border color combination box at the bottom of the page, 

• Click the  push button to the right of the combination box. 
In the color selection dialog 

• Select Blue, 
• Click the OK push button in the color selection dialog. 
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Changing the appearance of the subfile  
• Back in the properties dialog, under Style in the tree view at the left side, select 

Subfile. 
The subfile properties page opens on the right pane of the dialog as shown in 
Figure 0-4. 

 

Figure 0-4: Subfile properties dialog 

• Select Subfile record  - odd row in the combination box at the top of the page. 
In the Background  group box: 

• Click the  push button to the right of the Color combination box. 
In the Color chooser, 

• Select a light yellow 
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Figure 0-5: Color chooser for WebFacing properties 

Tip: If you are interested in the hex value of certain colors as they are used in the 
style classes, the color chooser displays the hex values. In Figure 0-5, the 
value: “FFFFCC”. 

• Click the OK push button on the color chooser dialog. 
Back on the properties dialog  

• Select Subfile record - even row in the combination box at the top of the page. 
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Figure 0-6: Properties page for subfile even rows 

In the Background  group box: 

• Click the  push button to the right of the Color combination box. 
In the Color chooser dialog: 

• Select a light green, 
• Click the OK push button. 

Now at run time the odd and even records will be displayed with different 
background colors. 
Next you will customize the appearance of the command key push buttons. 

Customizing the appearance of command keys  
Back in the properties dialog under Style in the tree view at the left side: 

• Select Command keys. 
The command key properties page opens on the right pane of the dialog as 
shown in Figure 0-7 
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Figure 0-7: Command keys property page 

Change the Foreground  color for all three states of the buttons: 
a. Default 
b. Rollover 
c. Button down 

Now you are done with the customization. 
• Click the OK push button on the properties dialog. 

Running the Web application 
Let's see the new look of your application. 

• Right-click the wflabxx project icon. 
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• Select Run on Server from the pop-up menu. 
• Run the application. 
• Click Prompt. 
>>> picture of customer selection subfile  

The application window shows different colors, and the subfile records are 
colored. The command key push buttons change color, depending on the 
state they are in. I hope you like your chosen colors. 

Analysis 
You completed Exercise: Working with more style properties. Here is what 
you did: First you started the Style Properties dialog and worked with three 
different style properties. Then you checked the changes by running the 
application. 
You are ready to move on. Next you add authentication support to this 
application so users have to identify themselves thru a signon dialog at 
runtime. Proceed to Exercise: Adding Authentication.
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ADDING AUTHENTICATION  

Introduction 
You will change the run-time behavior of your application. Instead of using 
the default user ID and password, the one you used when you selected the 
members to convert your DDS source, you will now force the user to provide 
his or her own signon information. You just have to remove the user ID and 
password from the CL command properties. 

 

The Goal of the Exercise 
The goal of this exercise is to practice securing your application by forcing 
authentication before the application is invoked. 
You will remove the user ID and password information and check it by 
running the application. 
At the end of this exercise, you should be able to:  

• Secure your application by forcing authentication before the application gets 
invoked 

• Explain the authentication support in the IBM WebFacing Tool 
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• Remove the default user ID and password 

Scenario 
You have tested your WebFaced application and for convenience have used 
your user ID and password as the default to avoid having to sign on every 
time you started the application. Now you need to move the application into 
production and you need the WebFaced application to prompt the users for 
sign on information when it gets started. 
This exercise goes thru the steps of enabling the authentication support. 

Using the project properties dialog 
You will use the CL command properties page of the run time to remove the 
default user ID and password information. 
In the WebFacing perspective in the WebFacing project view:  

• Right-click the wflabxx project icon. 
• Select Properties from the pop up menu. 

Providing run-time properties for the project       
• The Properties for wflabxx dialog opens. 
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Figure 0-1: Project properties dialog 

Under Runtime  in the list box at the left 
• Select order Entry Application 

The Order Entry application properties dialog gets displayed, as shown in  

 
Figure 0-2 Application properties page 
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• Deselect the Sign on with specified values check box. 
• Click the OK push button at the bottom of the properties dialog. 

You are back in the WebFacing project view 
You have changed the authentication behavior for this link (application). In 
this WebFacing project we only have one link, but imagine that you have 
multiple entry points into your application like a menu. You could specify a 
different authentication behavior for each of these links. 
On the other hand, if you have multiple links in a WebFacing project and the 
authentication should be the same for each different link, then you can 
specify an authentication rule on the project level. To do this, just go to the 
project properties page instead of the CL command properties page and 
specify the desired authentication behavior there.  

Running the Web application 
As before, run your application in the WAS test environment. 

• Click the Order Entry link. 
You will see the authentication dialog. 

 
Figure 0-3: WebFacing tool, Logon dialog 

• Specify your User Name  and Password , 
• Click the Logon push button on the authentication dialog 

The application will run like before, if the job environment for the user ID 
you specified is setup correct for this application. 
Now I’ll discuss how you can use your own authentication dialog, instead of 
using the one provided by the WebFacing tool. 

Using your own sign on dialog 
If you don’t like the sign on dialog that comes with the WebFacing tool, you 
can use your own dialog and tell the WebFacing runtime to invoke it instead 
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of the default dialog. A WebFacing project comes with a sample Logon.jsp  
file, which you can modify to the looks that you prefer in your environment. 
This section in the exercise guides you thru the steps of modifying the 
dialogs. 
I will then step you thru, how to specify in the WebFacing project properties 
that you now want to use your own Logon dialog. 

Changing the LOGON.html file 
In the WebFacing perspective use the WebFacing Project view: 

• Expand the wflabxx project node, if it’s not already expanded. 

 
Figure 0-4: WebFacing Project view with logon.html file 

You should see a logon.html  file. This logon.html  file is a sample that shows 
how the default Logon WebFacing dialog is built but it is there for you to 
customize it. This file is provided, to give you a sample to expand on. It also 
provides you with the html tags that you need if you want to incorporate the 
WebFacing logon function, but not the looks, into your own existing 
environment. You could copy these html statements into your own html 
page. 

Using Page Designer to add a heading to the Logon 
page 
You will use one of the Development Studio Client workbench tools to 
change the dialog to make it nicer. The tool is called Page Designer. Invoke 
Page Designer by: 
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Figure 0-5: Pop menu for logon.html file 

• Right clicking on the logon.html  icon in the WebFacing project view  

• Selecting the Open with option from the pop up menu 

• Selecting the Page Designer option from the pop up sub menu 

This will bring up the Page Designer on the upper right hand side of the workbench as 
shown in  
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Figure 0-6: Page Designer with WebFacing Logon on page 

First I want you to add your company name as a heading to the dialog. In the Page 
Designer window make sure you are on the Design page,  

• Click on the Design tab as shown in Figure 0-6 to make sure you are on the 
design page. 

 

Figure 0-7: Position cursor and click 

• Click in the Logon dialog just before the string Please type, as shown in 
Figure 0-7 
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Figure 0-8: Menu structure to add Heading2 tag to Logon dialog 

• Select Insert > Paragraph > Heading2 from the Workbench menu bar as 
shown in Figure 0-8 

A box opens on top of the dialog: 

 

Figure 0-9: New logon dialog, with cursor shape changed to drag enabled 

• In the box, enter your company name  

If you get two lines because you company name is too long, you can widen the logon 
box. 

• Move the cursor on top of one of the black rectangles on the side of the 
Logon frame. The cursor shape will change if it is in a two arrow head 
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shape like in Figure 0-9, you drag the side of the frame to make it wider or 
more narrow. 

• Adjust the frame width to your needs. 

One more thing you might want to do, is giving your new logon dialog a new color, 
lets go thru the steps to accomplish this and then you can test the new dialog. 

Using Page Designer to change the background color 
of the Logon page 

In the Page Designer: 

• Right click on the background  of the logon frame  

 

 

Figure 0-10: Pop up menu in Page Designer 

• Select Attributes from the pop up menu 

You will see in the lower right area of the workbench an Attribute editor coming up, 
as shown in Figure 0-11 
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Figure 0-11: Attributes editor in workbench 

In the Attributes editor: 

• Scroll down to the bottom of the Table page as shown in  

 

Figure 0-12: Selecting color yellow for background color of logon dialog 

• Select the arrow on the Color combination box to open the list 
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• Select yellow, or whatever back ground color you like for your logon page, 
from the list of color shown 

Tip: You could use the color picker push button  to point to an area on your 
desktop that has a nice color, click on that area, and the color from that area 
will be applied. 

Now your logon frame has a nice background color, the color in the Page 
Designer window has already been adjusted. 
To verify how the logon page would look in the browser go to the preview 
view by: 

• Selecting the Preview tab in Page Designer, as shown in Figure 0-13 

 
Figure 0-13: Logon page in Preview mode 

Another view in Page Designer is the Source view that actually brings up an 
editor with source for page you are working with. 

• Click on the Source tab 

The html source editor with the current page source comes up as shown in Figure 0-14. 
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Figure 0-14: Source editor window in Page Designer 

If you wanted to invoke the WebFacing logon action from a different dialog you would 
need to copy the three lines from this source that are highlighted in Figure 0-14 by 
arrows. 

You will need to invoke the WFLogon action and pass the userid and password input 
fields. 

Also the file name for your WebFacing Logon page has to be logon.html, that is the file 
the WebFacing runtime will try to send to the browser if you request to use you own 
Logon screen. 

You are ready to test the new logon page. 
• Save the changes you have made with Page Designer, by clicking the Save push 

button on the workbench toolbar as shown in Figure 0-15. 
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•  
Figure 0-15: Save push button in workbench toolbar 

• Close Page Designer by clicking on the X of its window bar  

 
Figure 0-16: X in Page designer window bar 

Changing the WebFacing properties to use a different 
Logon page 
In the WebFacing project view: 

• Right click on your wflabxx WebFacing project 
• Select Properties from the popup menu 

The Project properties dialog comes up as shown in Figure 0-17. 
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Figure 0-17: WebFacing Project properties dialog 

In the project properties dialog: 
• Select the Use user-defined signon page  check box  
• Press the OK push  button at the bottom of the properties page 

Now you can try out the new logon page. 

Running the Web application 
As before, run your application in the WAS test environment. 

• Click the Order Entry link. 
You will see the new authentication dialog. Do you like it? 
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Figure 0-18: The new Logon dialog 

 

• Specify your User Name  and Password , 
• Click the Logon push button on the authentication dialog 

The application will run like before, if the job environment for the user ID 
you specified is setup correct for this application. 

Analysis 
You have completed the Exercise: Adding Authentication. Here is what you 
did:  You used the project properties dialog for the Order Entry application 
to remove the default user ID and password information. Next you ran the 
application and where forced to provide authentication before the 
WebFacing runtime would start the WebFaced application. 
You then provided your own Logon page by changing the Default 
WebFacing Logon page. You use Page Designer to change the Logon page. 
You tested the new user defined Logon page 
You are ready to move on. Next you will learn about Display 
File mappings. If source member names and display file names 
don’t match, you need to take extra steps to let the WebFacing 
runtime know about these name differences. Go ahead to 
Exercise: Display file mapping.
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ENHANCING index.html PAGE USING WEB 
TOOLS 
 Introduction 

This exercise is not really related to using the WebFacing tool, you will use 
the Web tools in the Development Studio Client workbench to update the 
index.html file The index.html is the file created by the IBM WebFacing 
Tool that allows you to start your WebFaced application. You will use Page 
Designer and some related tools in the workbench to enhance the index.html  
page. Since the Page Designer user interface has been changed dramatically 
between Version 4 and Version 5 of the Development Studio Client I have 
separated this chapter into version 5 and version 4 exercises. 
The index.html  page, the WebFacing tool creates, is very plain. In this 
exercise you will add some color to it, as well as some pictures to make it a 
more interesting web page. This will give you a chance use some of the other 
tools in Development Studio Client. 

The Goal of the exercise 
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The goal of this exercise is to practice using some of the Web tools in 
Development Studio Client to enhance the index.html Web page. You will 
use Designer and some related tools and use them to enhance the index.html 
Web page, and then test the changed page. 
At the end of this exercise, you should be able to: 

• Use Page Designer 
• Use page designer components  to create a more attractive browser interface 
• Add a style sheet to the page 
• Add a heading that moves 
• Add a graphic from the sample gallery 
• Create a Logo with a web design tool 
• Test this new good looking insdex.html page 

Scenario 
You have created a WebFaced application and now want to enhance the look 
of the index.html  page to give the start page of this application a professional 
appearance. 
The Development Studio client workbench contains several tools to design 
and enhance web pages. Also with the workbench you have access to sample 
pictures, icons, animations, and more. You will use some of these tools and 
samples and enhance the page so it becomes more attractive. 
If you are working with Development Studio Client Version 5 continue here, 
if you are working with Version 4 go head to: Working with Development 
Studio Client Version 4; if your are using Version 5 continue here. 

Working with Development Studio Client Version 5 
The first step is to locate the index.html  file and to start Page Designer; in 
Page Designer you will link the page to cascading style sheet that comes as a 
sample with the workbench. 

Opening Page Designer 
In the Development Studio Client workbench: 

• Open the WebFacing perspective. 
You should now have the WebFacing project view in your workbench 
environment. 
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Figure 0-1: WebFacing project with index.html file 

 Expand the wflabxx WebFacing project 
• Right click on the index.html  icon 
• Select the Open option from the pop up menu. 

The Page Designer will appear in the upper right pane of the workbench and 
show the index.html page as the WebFacing tool created it. 

 
Figure 0-2: Page Designer showing the Design page 

Make sure that you are on the Design page in Page designer by: 
• Clicking on the Design tab 
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Working with page properties 
Move the links down by  

• Clicking before the first TAG, which shows as an exclamation mark. 

•  
Figure 0-3: Add some space in the upper half of the index.html page 

• Pressing the Enter key a number of times as shown in Figure 0-3 
To change the page properties: 

 
Figure 0-4: Page properties on pop up menu in Page Designer 

• Right-click the background of the index.html page in Page Designer. 

• Select the Page Properties… option from the pop-up menu. 
The Page Properties dialog opens as shown in. 
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Figure 0-5: Page properties dialog 

• Change the Page title field to Order Entry 
• Click the OK push button on the Page Properties dialog 

When this page is shown in a browser, the Window title bar of the browser 
will now display Order Entry 

Linking a Cascading Style Sheet to the web page 
Now you will add a style to the web page, you can use a style that is used in 
your company or you can use one of the sample style sheets that are 
provided in Development Studio Client. 
In the lower left pane in the workbench 
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Figure 0-6: Page Designer, linking a style to the web page 

 As shown in Figure 0-6 
• Click on the Gallery tab, if the Gallery view isn’t already displayed 

• Scroll to the bottom of the Gallery view, until can see the Style Sheet 
icon 

• Click on the Style Sheet icon, to select it 
• Click on the Thumbnail tab  on the right bottom pane in the workbench 

You should see thumbnail icons of all the styles available as shown in Figure 0-6. 
In the thumbnail view: 

• Scroll down to the bottom, until you see style sheet t12.css in the list, or 
select a style sheet that you like best. 

• Click on the thumbnail picture of t12.css with your left mouse button 
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• Keep the left mouse button down and drag the mouse cursor to the Page 

Designer window. The cursor will change from this shape , to this 

shape , when the latter cursor shape appears in the Page Designer 
window, let go of the mouse left button. 

After a short while the Style sheet properties will be applied by magic and the 
colors in the page will change to the style sheet definitions, as in Figure 0-7 

 
Figure 0-7: Index.html page with style properties applied 

Designing and adding a Logo 
Now that you have the overall web page look specified I want you to use the 
WebArt Designer to create a Logo that you then will add to this page. 
To start the WebArt Designer: 

 
Figure 0-8: Tools menu with WebArt Designer 
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• Select the Tools menu option in the workbench 

• Select the WebArt Designer from the pull down menu 

The WebArt designer will come up as shown in Figure 0-9 

 

Figure 0-9: WebArt Designer dialog 

The WebArt designer shows the Template Gallery on the left, where you 
find sample of logos, buttons, rollovers, images and more. The big white 
area in middle of the dialog is the canvas that is used to work with objects 
that you want to create or change. In this exercise I want you to create a logo 
from scratch, you could also select one from the template gallery as the base 
for your own logo. 

• Click on the Create Logo button above the canvas, as shown by the arrow in 
Figure 0-9, or use the Object >> Create Logo menu options. 

This will bring up the Logo wizard dialog, In the Logo wizard: 
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Figure 0-10: Logo wizard dialog 

• Enter your company name  in the Text entry fie ld and in the next of the Text entry 
field wflabxx 

• Select font name  Comic Sans MS 

• Select Font size 46 

• Select the Center radio button in the Alignment group box 

Notice in the upper right corner of the dialog, a sample of the logo as specified at the 
moment is being displayed. 

Forward to the next page of the wizard by: 

• Clicking on the Next > push button 

The Select color page of the wizard will be displayed, as shown in Figure 0-11, on this 
page: 
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Figure 0-11: Logo wizard with Select Color page 

• Click on the gradation type push button, the middle one of the three type push 
buttons. 

Note: The other push buttons select color types: solid and textured. 

• Select beer from the colors available, or any other color you like best, just scroll 
thru the list to find a gradation you like. 

Note: You can change the colors by pressing the Others… push button on this dialog 
and create you own gradation. 

• Press the Next > push button, to move forward to the next page. 

The Select Outline page appears as shown in Figure 0-12 
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Figure 0-12: Logo wizard with Select Outline page 

• Select the Seal outline from the list, or any outline you like best 

• Press the Next > push button  
You see the Select Text Effect page of the logo wizard as shown on  

 
Figure 0-13: Logo wizard with Select Text Effect page 

• Select the Emboss text effect, or one that you like best. 
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• Click the Finish push button, 
This will get you back to WebArt designer window as shown in  

 
Figure 0-14: WebArt designer with new logo object 

Resize the logo object on the canvas by: 
• Clicking on the logo object to select it  

• Move the cursor to the rectangle at the right bottom corners of the object, watch 
the cursor changing shape 

• Drag the rectangle up and to the left so the object becomes smaller as shown in 
Figure 0-14 

Now you need to save this object, first I want you save it as a WebArt object, 
that allows you later on to work with object again in WebArt designer, but 
you can’t use that format for your webpage. 

• Select the File option on the WebArt designer menu bar 

• Select Save from the pull down menu 
The Save dialog comes up as shown in Figure 0-15 
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Figure 0-15: WebArt Designer save dialog 

• Enter mylogo in the File name entry field 
• Click the Save push button 

Now we need to save the object in a form that can be displayed on a web 
page. 

• Select the File menu option from the WebArt designer menu bar again 
• Select option Save wizard for web… from the pull down menu 

The save wizard dialog is displayed as shown in Figure 0-16 

 
Figure 0-16: Save wizard with Specify Objects page 

• Select the Save the selected object radio button 
• Click the Next > push button 

Now the Select File format page is displayed as in  
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Figure 0-17: Save wizard with Select File Format page 

• Select the GIF radio button  
• Click the Next > push button 

On the gif format page that appears as shown in Figure 0-18 

 
Figure 0-18: Save wizard with GIF Format page 
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• Click the Finish  push button 
On the save dialog that comes up 

 
Figure 0-19: Save dialog 

• Make sure the directory is pointing to the Web Content directory in the 
workspace where your WebFacing project is located, if you used the default for 
the workspace location it is like in Figure 0-20 

•  

Figure 0-20: Directory structure showing default workspace location 

• Enter mylogo in the filename entry field 
• Click the Save push button 

On the message box the shows as shown in Figure 0-21 

 
Figure 0-21: Message dialog when saving object as jpeg file format 

• Click the Yes  push button 
The dialog GIF attribute settings shows like in  
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Figure 0-22: GIF attribute dialog 

• Click the OK push button 
Close the WebArt designer by: 

• Selecting the File option from the menu bar 
• Selecting the Exit menu option from the pull down menu 

You are back in the workbench in the WebFacing perspective 
showing the WebFacing project view 

Switch to the Navigator view by: 
• Clicking on the Navigator tab  
• Expand the wflabxx web project 
• Expand the Web Content folder 
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Figure 0-23: View of Web Content directory with mylogo.gif 

The mylogo.gif file should appear in the list as shown in Figure 0-23 
If it doesn’t appear, the list might need to be refreshed. 

• Right click on the Web Content folder icon 
• Select the Refresh  option from the pop up menu 

Hopefully you can see the file now in the Web Content folder, if not, go to Windows 
explorer and search for the mylogo.gif on your hard drive, then move it to the Web 
Content folder in the WDSC workspace. If you didn’t use the default location as shown 
in Figure 0-20, do a search for the workspace and the wflabxx directory in it. Move the 
mylogo.gif file into the Web Content sub directory under the wflabxx directory 
Now you can take the logo and put it on your web page that is still open in page 
designer, if Page Designer has been closed just open the index.html  file. 
In the Navigator view: 
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Figure 0-24: Dragging the mylogo.gif file onto the design page 

• Select the mylogo.gif file 
• Keep the left mouse button pressed 
• Drag the file to the upper left corner in the page designer window 
• Let the mouse button go 

The logo is placed on the design page as shown in Figure 0-24 

Adding a heading 1 tag to the page 
Now I want you to insert a nice heading below the logo 

• Position the cursor just below the Logo at the first BR tag 
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Figure 0-25: Selecting to insert a Heading 1 tag 

• Select Insert from the workbench menu bar 
• Select Paragraph from the pop up menu 
• Select Heading 1  from the sub menu 

A frame appears that allows you to enter text: 
• Enter your company name Order Entry, as shown in Figure 0-26 

 
Figure 0-26: Web page with logo and title 

Now I want you to use one of the sample pictures that come with 
Development Studio Client and place this picture on the page. 
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Adding a picture to the page 
In the workbench underneath the Navigator view  

 
Figure 0-27: Dragging a picture onto the design page 

• Select the Gallery tab 
• Expand the Image folder 
• Select the Illustration folder 

On the dialog pane beside the gallery view: 
• Select one of the sample illustrations in Figure 0-27, I use file cut025.gif 
• Drag that picture onto the design window below the heading 

The Design window now contains a picture as shown in Figure 0-28 
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Figure 0-28: Design window with picture added 

You are almost done, one more thing, I want you to add a moving text onto 
the page. 

Adding moving text to the page 
• Position the cursor in the design window underneath the picture 
• Select the Insert menu option from the workbench menu bar 
• Select the Paragraph option from the pull down menu 
• Select the Heading 3  option from the sub menu 

 
Figure 0-29: Web page with Heading 3 frame 
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Leave the cursor positioned inside the heading 3 frame  

 
Figure 0-30: Selection of the Marquee option 

• Select the Insert menu option form the workbench menu bar 
• Select the Others option from the pull down menu 
• Select the Marquee .. option from the sub menu 

The Insert Marquee dialog comes up as shown in  
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Figure 0-31: Insert Marquee dialog 

• Enter into the Text entry field: Please select link to start application 
• Select Slide in the Movement combo box 
• Select Finite in the Repetition  combo box 
• Select 1 in the Count combo box 
The two last selections just avoid the text sliding in forever and not 

standing still, if you think your user can stand some more movement 

on the page feel free to change these settings . 

• Select Lime  in the Background color combo box 
• Click the OK push button 

The Design page should look like Figure 0-32 
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Figure 0-32: Design page with Header 3 text 

To save some space get rid of some of the line break tags 
• Position the cursor on the BR tag  

• Press the Delete key until the links appear on your page as shown in Figure 0-33 
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Figure 0-33: Page designer design page with completed page 

To have a look at the page, as it would appear in a browser, just: 
• Click on the Preview tab at the bottom of the design page 

You will notice that your heading 3 text is sliding in  
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Figure 0-34: Web page shown in browser, text moving in 

Changing the text color in Page designer 
You notice that the Text color and the background interfere a little bit one 
easy way of changing this, is to apply another color to certain areas of the 
text. To do that, go back to the Design page: 

• Click on the Design tab 
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Figure 0-35: Selecting color choice for selected text area 

• Select the text (IBM in Figure 0-35) you want to change color on by swiping the 
area with the mouse cursor 

On the bottom dialog underneath the Page Designer window 
• Select the Colors tab 

• Select a color with your mouse cursor 
• Select the Text color option form the colors dialog 
• Select the Set as Text Color option from the pull down menu 

You are done; now the selected text will be displayed with the color you selected 
for it 
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Clean up the page 
One more thing to do, I want you remove the default text that was added by the 

WebFacing tool as show in Figure 0-36 

 
Figure 0-36: Text to be deleted from web page 

• Select the text  

• Press the Delete key 
• Select the Preview tab to view your completed page it should look like similar to 

Figure 0-37 

 
Figure 0-37: Completed web page in Preview window 

• Save the file index.html  
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• Exit Page Designer 
In Navigator view or WebFacing project view: 

• Right mouse click on the wflabxx icon  
• Select the Run on Server option from the pop up menu 
Your new designed index.html page will come up and you can run your 

application 
Move forward to heading Analysis, in the next section I describe the same 

scenario just going thru Development Studio Client Version 4 user interface. 

Working with Development Studio Client Version 4 
The first step is to open the Web perspective to get the right dialogs for the 
job you’re your view. You need to then copy the index.html file that you 
work with. This is necessary because the Page Designer will remove one line 
of source from the file because it assumes this line is incorrect. 
Unfortunately WebFacing needs this line, so after you are done with Page 
Designer, you will copy this line from the backup you are making and it to 
the updated index.html. If you didn’t do this, the links on this page would 
not work anymore  
After making the backup copy you are ready to use the index.html file with 
Page Designer, in Page Designer you will link the page to a cascading style 
sheet that comes as a sample with the workbench. You will change the 
heading of the page, add you own logo, and add a mo ving text. 

Switching to the Navigator view 
In the Development Studio Client workbench: 
Open the Web perspective: 
 

 
Figure 0-38: Opening the Web perspective 

• Select the Perspective option on the workbench menu 
• Select the Open option on the pull down menu 
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• Select the Other… option from the sub menu 
On the Select Perspective dialog as shown in Figure 0-39 

 
Figure 0-39: Select Perspective dialog 

• Select Web from the list of available perspectives 
• Click the OK push button 

You should now have the Web perspective open in your workbench with the 
Navigator view. You will use this view to locate the index.html file and then 
work with it. 

• Expand the wflabxx project. 
• Expand the webApplication  folder. 
• Locate the index.html  file in this folder. 

As mentioned before, you are making a backup copy of this file: 
• Right click on the index.html  icon 
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Figure 0-40: Select the Copy action 

• Select Copy from the pop up menu  

The Folder Selection dialog comes up as shown in picture 

 
Figure 0-41: Folder Selection dialog 

• Click the OK button on the Folder Selection dialog 
A file with the name Copy of index.html  will be created, you will use this file 
later on to copy a line and add it to the original file.  
The next step is to look at the index.html page and change it using Page 
Designer. 

Starting Page Designer 
Page Designer is comparable to SDA for 5250 panels or a GUI builder for GUI 
pages, but, as its name indicates, it helps with designing Web pages. As in 
SDA or CODE Designer, instead of typing source statements in an editor, Page 
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Designer creates the source for you from your design choices. Here, the 
source that is generated is using HTML tags instead of DDS statements.  
To invoke Page Designer: 

• Double-click the icon of the index.html  file. 
The Page Designer opens on the right side of the workbench.  

This is where you can enhance the Web page. 

 

 

Figure 0-42: Page Designer with three tabs, one of them the Design tab  

You are ready to use Page Designer. You will notice three tabs at the bottom 
of the Page Designer work area. These tabs allow you to switch between 
different views  
These views are: 

• The normal Design view 
• An HTML source editor view 
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• A Preview view, which shows the page in its current state in a browser window. 
Make sure you are on the Design page by: 

• Clicking the Design tab, as shown in Figure 0-42. 

Working with page properties 
• Move the labels down by clicking before the first TAG, which shows as an 

exclamation mark. 

• Press the Enter key a number of times. 
• Right-click the background of the design work area. 

• Select Page Properties option from the pop-up menu. 
The Attributes dialog opens. 

• Change the Page title field to Order entry 

 
Figure 0-43: Adding blank space to the web page 
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Figure 0-44: Page properties page 

• Click the OK push button to close the Attributes dialog box. 
The page now got a title. Now you’ll give this page more color you’ll add 
some background color and attribute definitions for text and links by linking 
this page to a style sheet. 

Linking a Cascading Style Sheet to the web page 
You will add a style sheet to the web page, you can use a style sheet that is 
used in your company or you can use one of the sample style sheets that are 
provided in Development Studio Client. 
In the lower left pane in the workbench 
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Figure 0-45: Page Designer, linking a style to the web page 

 

 As shown in Figure 0-45 
At the right bottom pane in the workbench 

• Click on the Thumbnail tab  
At the left bottom pane in the workbench: 

• Click on the Gallery tab  
• Scroll to the bottom of the Gallery view, until you can see the Style Sheet 

icon 
• Click on the Style Sheet icon, to select it 

You should see thumbnail icons of all the styles available as shown in Figure 
0-45. In the thumbnail view: 
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• Scroll down to the bottom, until you see style sheet t12.css in the list, or 
select a style sheet that you like best. 

• Click on the icon of t12.css with your left mouse button 
• Keep the left mouse button down and drag the mouse cursor to the Page 

Designer window. The cursor will change from this shape , to this 

shape , when the latter cursor shape appears in the Page Designer 
window, let go of the mouse left button. 

After a short while, the Style sheet properties will be applied by magic and the 
colors in the page will change to the style sheet definitions, as in Figure 0-46, 

which gives you a gray flavor of the different colors, but it should look very nice 
on your monitor  

 
Figure 0-46: Index.html page with style properties applied   >>>>>>>>>Need this in V4 
version>>>>>>>> 

 

Adding a Logo to the page using the logo wizard  
Now you’ll add a Logo using the Logo wizard that comes with Development 
Studio Client. 

• Click on the first line break tag in the upper left corner of the design page, to 
position the cursor at the target location for the logo. 
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Figure 0-47:  Start Logo wizard from Insert menu 

• Select Insert à  Logo from the workbench main menu bar. 
The Logo wizard opens. 

 
Figure 0-48: Adding text for the Logo 

• In the Text field on top of the wizard page, type: 
o wflabxx 
o Your company name , (in my sample IBM) , as in Figure 0-48 

• Click the Text attributes push button on the Logo wizard page. 
The first of four text attribute pages appears: 
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Figure 0-49: Logo wizard with text attributes page 

• Select Comic Sans MS in the Font name combination box 
• Select 46 in the Font size combination box 
• Select the Bold check box 
• Select the Center radio button 
• Click the Next > push button 

The Color Selection  page comes up: 
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Figure 0-50: Logo wizard text attribute color selection page 

• Select type gradation, by clicking its pushbutton 

• Click the color beer push button. Maybe, I am influenced by my German 
background, but I think beer is a really nice color combination. The liquid stuff 
is not bad either.  

•  Click the Next > pushbutton 
The Select Outline page appears as shown in Figure 0-51: 
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Figure 0-51: Logo wizard text attributes Select Outline page 

• Click the Seal push button from the Type list 
• Click the Next > push button 

The Select Text Effects page appears as shown in Figure 0-52 

 
Figure 0-52: Logo wizard text attributes Select Text Effect page 

• Click the Emboss type push button 
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• Click the Finish  push button 
You are back the Create Logo wizard  page, if you like, you might want to 
select a nice background for your Logo by using the Background Image push 
button. I’ll let you discover this feature on your own. 
On the Create Logo Wizard  page: 

 
Figure 0-53: Create Logo wizard, ready to Finish 

•  Click the Finish  push button 
Back in Page Designer, the Logo will appear, it will be a bit big, so I want 
you to re-size it: 
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Figure 0-54: Re-sizing the Logo in Page Designer 

Select the Logo object in Page Designer by: 
• Clicking on it  

• Locate the little square on its right bottom corner 

• Move the cursor on top of it, so the cursor changes shape to 2 arrows 

• Click on the rectangle 

• Drag the rectangle towards the upper left corner to shrink it  

Figure 0-54 gives you an indication how small it should get, but don’t worry it doesn’t 
matter if it not exactly the way I sized it in the picture. As long as you like your logo and 
its size you are doing just fine 

You are done with the Logo design but some more work has to be done. 

Adding a heading 1 tag to the page 
Now I want you to insert a nice heading below the logo 
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• Position the cursor just below the Logo at the first line break tag as shown in 
Figure 0-55 

 
Figure 0-55: Menu structure to insert a Heading 1 tag 

• Select Insert from the workbench menu bar 
• Select Paragraph from the pop up menu 
• Select Heading 1  from the sub menu 

A frame appears that allows you to enter text: 
• Enter your company name Order Entry, as shown in Figure 0-56 

 
Figure 0-56: Web page with logo and title 
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Now I want you to enhance this page even more by using one of the sample 
pictures that come with Development Studio Client and placing this picture 
on the page. 

Adding a picture to the page 
In the workbench underneath the Navigator view  

 
Figure 0-57: Dragging a picture onto the design page 

• Select the Gallery tab 
• Expand the Image folder 
• Select the Illustration folder 

On the dialog pane beside the gallery view  
• Click on the Thumbnail tab to show the selection of illustrations available. 
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• Select one of the sample illustrations as shown in Figure 0-57, where I use file 
u005cut.gif 

• Drag that picture onto the design window to a position below the heading 
The Design window now contains a picture as shown in Figure 0-58 

 
Figure 0-58: Design window with picture added 

You might want to re -size the picture a little bit to fill more o f the page 
You are almost done, one more thing, I want you to add a moving text onto 
the page. 

Adding moving text to the page 
• Position the cursor in the design window underneath the picture 
• Select the Insert menu option from the workbench menu bar 
• Select the Paragraph option from the pull down menu 
• Select the Heading 3  option from the sub menu 

A heading 3 frame gets created on the design page, as shown in Figure 0-59  
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Figure 0-59: Web page with Heading 3 frame 

Leave the cursor positioned inside the heading 3 frame  
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Figure 0-60: Selection of the Marquee option 

• Select the Insert menu option from the workbench menu bar 

• Select the Others option from the pull down menu 
• Select the Marquee .. option from the sub menu 

The Insert Marquee dialog comes up as shown in Figure 0-61 
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Figure 0-61: Insert Marquee dialog 

• Enter into the Text entry field: Please select link to start application 
• Select Slide in the Movement combo box 
• Select Finite in the Repetition  combo box 
• Select 1 in the Count combo box 
The two last selections just avoid the text sliding in forever and not standing still, if  

you think your users can stand some more movement on the page feel free to change 

these settings. 

• Select a nice green color in the Background color combo box 
• Click the OK push button 

The Design page should look like Figure 0-62 
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Figure 0-62: Design page with Header 3 text 

To save some space get rid of some of the line break tags 
• Position the cursor on the line break tags as shown in Figure 0-62 

• Press the delete key until the links appear on your page as shown in Figure 0-63 
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Figure 0-63: Page designer design page with completed page 

To have a look at the page as it would appear in a browser: 
• Click on the Preview tab at the bottom of the design page 

You will notice that your heading 3 text is sliding in  
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Figure 0-64: Web page shown in browser, text moving in 

Changing the text color in Page designer 
You notice that the Text color in the heading 1 area and the background 
interfere a little bit one easy way of changing this, is to apply another color 
to certain areas of the text. To do that, go back to the design page: 

• Click on the Design tab 
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Figure 0-65: Selecting color choice for selected text area 

• Select the text (IBM in Figure 0-65), you want to change color on, by swiping 
the area with the mouse cursor 

On the bottom dialog underneath the Page Designer window 
• Select the Colors tab 

• Select a color with your mouse cursor from the color palette 
• Select the Text color option from the colors dialog 
• Select the Text Color option from the pull down menu 
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You are done, now the selected text will be displayed in the selected color 

Clean up the page 
One more thing to do, I want you to remove the default text that was added by 

the WebFacing tool as shown in Figure 0-66 

 
Figure 0-66: Text to be deleted from web page 

• Select the text  

• Press the Delete key 
• Select the Preview tab to view your completed page, it should look similar to 

what is shown in Figure 0-67 
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Figure 0-67: Completed web page in Preview window 

• Save the file index.html  
You are almost ready to run the application again. I mentioned in the 
beginning that Page Designer will delete one line from the html source 
which it assumes is incorrect, but actually it is needed on the page, Page 
Designer in Version 5 got fixed and in Version 5 you don’t have to worry 
about it, but since you are still working in Version 4, I’ll show you how to 
fix this. 
You need to open Page Designer with the backup copy of the index.html file, 
in the Navigator view: 
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Figure 0-68: Load file Copy of index.html  

• Double click on file Copy of index.html  

Another Page Designer session for the Copy of index.html  file gets started. In this new 
Page Designer session: 

• Click the Source tab 

In the source editor as shown in Figure 0-69: 
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Figure 0-69: Editor with source of Copy of index.html 

• Scroll down to near the bottom  

Around line 47 you will see a line with a warning icon: 

• Select the <a id=”wfLink” href=” ”> </a> string, beside the body tag, as 
shown in Figure 0-69 

• Right click on the selected text  

• Select copy from the pop up menu 

Page Designer should still be open with the index.html file, if not open it: 
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Figure 0-70: Page Designer with index.html file and copied string 

• Click on the Page Designer window bar of the open index.html file, to give it 
focus 

• Click on the Source tab, to switch to the source editor window 
In the source editor window of index.html file: 

• Locate the line with the <body>  tag 
• Position the cursor behind the <body> tag as indicated by the arrow in 

Figure 0-70 
• Add a blank character behind the <body> tag 

• Right click after the added blank  character 
• Select paste from the pop up menu 

The string from the Copy of index.html should now be now also located in the 
index.html file, as shown in Figure 0-70 

• Close Page Designer for the Copy of index.html file 
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• Close Page Designer for the index.html file 
• Click Yes when asked whether you want to save any changes in the file 

Switch to the WebFacing perspective by: 

 
Figure 0-71: Workbench side toolbar with open perspectives  

• Clicking on its icon on the side toolbar of the workbench, as shown in 
Figure 0-71  

In the Navigator view or WebFacing project view: 
• Right mouse click on the wflabxx icon  
• Select the Run on Server option from the pop up menu 
Your new designed index.html page will come up and you can run your 

application 
Move forward to heading Analysis, in the next section I describe the same 

scenario just going thru Development Studio Client Version 4 user interface. 

Analysis 
You have completed Exercise: Enhancing a web page using Web Tools. 
Here is what you did. In this exercise you enhanced the index.html page 
using the Page Designer tool. You learned how to design a Web page using 
Page Designer in Development Studio Client; how to create a heading, how 
to add an image, how to create a LOGO and add it, and how to a add 
Marquee to a web page. 
After this sidestep into web tools, I now get you back to WebFacing, the next 
two exe rcises cover tracing and debugging. 
You are ready to move on to Exercise: Tracing the WebFacing Runtime.
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 Appendix 1 

EXPORTING TO iSERIES  
WEBSPHERE APPLICATION SERVER 4.0 
 Introduction 

Until now you have only tested in the local WAS test environment. Now you 
are ready to test on iSeries IBM WebSphere Application Server. In this 
exercise, you will export files created by the WebFacing Tool to a remote 
WebSphere Application server. 

The Goal of the exercise 
This exercise walks you through the steps of publishing your WebFacing 
files to a remote WebSphere Application Server 4.0 environment on an 
iSeries system. It also explains how to create your Web application using the 
WebSphere Administrative Server admin console.  
If you are working with iSeries WebSphere Application Server Version 4.0 
instead of Version 3.5, follow these instructions to create the Web 
application from an .EAR file. The IBM WebFacing Tool will create the .EAR 
file. 
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You will start the Export tool, specify export information, start the 
administrative console and use it to navigate through the server environment, 
create a Web application using the wizard, and start the Web application. 
The WebFacing project files will be copied to a remote Web server where 
the application server will be able to find and use them. 
At the end of this exercise, you should be able to:  

• Specify the export information needed using the WebFacing Tool and wizards 
• Copy specified files to the Web server using the WebFacing Tool export 

function 
You will also learn how to use the WebSphere Administrative Server admin 
console of the WebSphere Application Server.  You will be able to start it 
and gain an understanding of the different parts of the console. You will be 
able to go through all the steps needed to define all the pieces needed to run 
on the server applications that were created using the IBM WebFacing Tool:  

• Use the WebSphere Administrative Server admin console 
• Navigate through the console environment 
• Use the console and its wizards to create the Web application needed to run the 

Web-enabled application 
• Use the console to start the Web application 

Scenario 

You have tested the application in the WAS test environment and you are ready to move it 
to your iSeries WAS environment. You are running WAS, Version 4.0 on your iSeries. 
You have the Was 4.0 administration console installed on your workstation.  

Exporting the files to the Web server 
In this section I describe how to export the WebFacing project files to a 
WebSphere Application Server, Version 4. If you need to target Version 3.5, 
use the instructions in Exporting to the iSeries WebSphere Application 
Server 3.5.  

 
Now you will publish the files generated by the IBM WebFacing Tool to the 
remote WebSphere Application Server directories. Before you perform the 
export steps, you must map a network drive to the root directory of your 
Web server iSeries IFS environment.  
If you are unsure how to do this, please ask your instructor or follow these 
instructions. 
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• Right-click the Network Neighborhood or (My Network Places) icon on the 
desktop. 

• Select Map Network drive  from the pop-up menu.  

 
Figure 0-1: Network drive amp dialog for Windows 2000 

• In the Folder field of the Map Network Drive dialog box, enter two  backslashes 
(\\) and the Netserver name of your Web server. Ask your instructor for the 
exact name. The folder needs to include \root, for example,  \\S400A\root 

• Click the Finish push button. 
When the mapping is done, you are ready to export. 

Selecting the EAR file to export 
• Go back to the WebSphere Development Studio Client workbench and the 

WebFacing perspective. 
• Select File à  Export from the workbench menu bar. 

The Select page of the Export wizard opens: 
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Figure 0-2: Export dialog 

 
 
• Select the EAR file icon.  

An EAR file is a compressed Enterprise Application Archive, and it contains 
all the files needed for the Web application. 

• Click the Next> push button. The EAR Export page opens. 

Completing the EAR file export information 
• Select the name of the resources you used when creating your WebFacing project. 

The default is  DefaultEAR.  
Since I asked you to change this to wflabxxEAR, select this file from the 
combo box drop down list. 



WebFacing hands-on Lab                                                                       Page 203 of 220 

 
CW                                                                                                  © Copyright IBM 

Corporation 2002 
Course material may not be reproduced in whole or in part 

without the prior consent of IBM 
 

 
Figure 0-3: EAR file export dialog 

• In the field for export resources, specify  where to put the EAR file by entering the 
drive and directory structure of your Web server, it will look something like this: 
x:\qibm\UserData\wflabxx   
where x: is the drive letter of the iSeries network drive that you mapped in the 
previous step. 

The export resource field should contain this data:  
  X:\qibm\UserData\wflabxx\wflabxx.ear 

 where x: is the drive mapped from your iSeries system in the previous 
steps. 

• Select the Override existing resource without warning check box. 
• Click the Finish  push button to copy the files to the EAR file. 

 If a message asks you to create a directory or delete an existing file: 
• Click the OK push button or Yes and continue 

Creating a Version 4.0 Web application with the 
WebSphere Administrative Server admin console  

In this section you will start the WebSphere Administrative Server admin 
console of WebSphere Application Server. The console allows you to 
manage your server environment. 
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Starting the WebSphere Application Server Administrative Server admin 
console 
To use the Version 3.5 WebSphere Administrative Server admin console and 
create a Web application for that version of the server, use Appendix 2 : 
Exporting to iSeries WebSphere Application Server 3.5. 

• To start the console, open a DOS command prompt and type: 

 adminclient <server_name> <port_number> 

<server_name> is  the iSeries server that runs WebSphere Application 
Server.  

Important: This entry is case-sensitive. 

<port_number> is 900 for default port  
 

You need to specify the correct bootstrap port number for the administrative 
server you use. If you don’t know it ask your administrator, if you are 
working with the default instance port 900 is its default port. This will take a 
while; please be patient until the console opens. 
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Working with the WebSphere Administrative Server 
admin console 

This is the view you should see after the console comes up connected to the 
default administration server. 
 

 
Figure 0-4: WAS Version 4, administration console 

 
Make sure that the console message box at the bottom of the view contains 
the message Console Ready. Then check whether the application already 
exists from a previous exe rcise.  

• Expand the WebSphere Administrative Domain by clicking the plus sign (+) beside 
it, if it is not already expanded. 

• Expand the Enterprise Applications by clicking the plus sign (+) beside it, if it is not 
already expanded.  
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Figure 0-5: Expanded tree view in administration console 

 
• Look for the wflabxx application in the tree. 

 If it exists:  
• Right-click the wflabxx icon. 
• Select Stop from the pop-up menu. 

After the Stop has completed successfully: 

•  Right-click the wflabxx icon. 
• Select Remove from the pop-up menu.  

The application is removed, you can re-create it now. 

Creating a new application 
Now you are ready to create your WAS application. 

• Right-click the Enterprise Applications icon. 
• Select Install Enterprise Application  from the pop-up menu. 

The Install Enterprise Application wizard opens 
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Figure 0-6: Install Enterprise Application Wizard dialog 

 
 

• Select the Install Application (*.ear)  radio button. 
• Now specify the name of the EAR file and the directory path that you exported 

the EAR file to. Do you still reme mber it? 
• Click Browse to locate it. If you followed our instructions, it is  

x:/Qibm/UserData/wflabxx/wflabxx.ear  
• Specify the application name wflabxx 
• Click the Finish push button. You should eventually see this completion 

message: 
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Figure 0-7: Completion message 

If you get an error message you might not be authorized to change the 
directories, so make sure you are using the correct RWX authority. 

 
Now you need to tell the HTTP server that this Web application exists and 
what the URL for this application is. The WebSphere Administrative Server 
admin console allows you to do this directly.  

• Expand the Nodes folder. 
• Right-click the node that contains the iSeries system name  you are working 

with. 

 
Figure 0-8: Regenerate Webserver Plugin 
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• Select Regen Webserver Plugin from the pop-up menu. 

Now the HTTP server knows about this new application.  
 

Note: Another way to force the HTTP server to pick up this information is to restart 
the HTTP server.  

 
 

Looking at application information 
If you want to see where to find your application in the WAS environment, 
here are the steps to look at this information. If you are not interested, skip 
ahead to “Exiting the WebSphere Admin istrative Server admin console.”  
 
In the console tree view, expand the system node that has the name of the 
iSeries system you are working with. 

• Expand the Application Servers folder. 
• Expand the Default Server folder. 
• Click the Installed Web Modules . 

 
In the right top list you can see all applications in the Web module of this 
application server. 
 

• Scroll down the list of applications until you find your wflabxx application. 
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Figure 0-9: Application details on administration console 

• Click wflabxx. 

 
The notebook underneath the application list contains the detailed 
description of this application.  

Exiting the WebSphere Administrative Server admin 
console 
 
This is all you need to do in the WebSphere Administrative Server admin 
console of the IBM WebSphere Application Server.  

• Click the minimize button on the top right corner of the console. 

Note: Before you run the Application you need to change the Application server 
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settings to support UTF-8. The WebFacing help text describes the steps 
required  

Running the Web-enabled application 
You are now ready to run the Web-enabled application.  

• Start Internet Explorer and type 
HTTP://servername:portnumber/wflabxx  
Your application index html page should open. If it doesn’t, check the URL. 

• Check that both the HTTP server and WebSphere Application Sever have been 
started and are running. 

You might want to go back to the Administrative Server admin console of 
WebSphere Application Server and try the following: 

• Right-click your server instance. 
• Select Stop from the pop-up menu. 

A message confirms that the server is stopped. 
• Right-click again on the Server instance .  
• Select Start from the pop-up menu. 

 
If it still doesn’t work, there are troubleshooting guides on the Web, as well 
as FAQs and newsgroups where you might find an explanation of your 
situation and more detailed information. 
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 2 

Appendix 2 (OPTIONAL): EXPORTING TO iSERIES 
WEBSPHERE APPLICATION SERVER 3.5 
  

Introduction 

You will learn how to export all files to the correct Web server directories. You will also learn 
how to start the Administrative Server admin console of IBM WebSphere Application Server, 
Version 3.5. The console allows you to manage your WebSphere Application Server 
environment. 

 
The goal of the exercise 

The goal of this exercise is to practice creating the Web application that is needed to run the 
application you created using the IBM WebFacing Tool. Also, you will create the JSP pages and 
data beans needed for the Web-enabled application. You will copy these artifacts to the Web 
server where the Web application can find them and use them. 
You will specify export information, start the export process, start the WebSphere Administrative 
Server admin console, navigate through the WebSphere Application Server environment using 
the console, create a Web application using the wizard, and start the Web application.  
 
At the end of this exercise, you should be able to:  
 
• Specify and create all parts needed for the Web-enabled application 
• Specify the export information needed using the WebFacing Tool and wizards 
• Copy specified files to the Web server using the WebFacing Tool export function 
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You will also learn how to use the Administrative Server admin console of the WebSphere 
Application Server. You will be able to start it and gain an understanding of the different parts of 
the console. You will be able to go through all the steps needed to define all the pieces needed 
to run on the server applications that were created using the IBM WebFacing Tool: 
 
• Start the WebSphere Administrative Server admin console in Version 3.5 and describe its 

parts  
• Navigate through the console environment 
• Use the console and its wizards to create the Web application needed to run the Web-

enabled application 
• Use the console to start the Web application 

 
Scenario 
 
Using the WebFacing Tool to Start the Conversion   

If the WebFacing perspective with your project is not visible or WebSphere Development Studio 
Client is not started: 
____  1.   Start WDSC as in previous exercises. 
____  2.   Select the WebFacing perspective in the workbench. 

 
If the WebFacing Tool project list contains multiple projects, somebody else has 
worked in your environment before and these are leftover projects; just ignore them. 

 
Exporting the files to the Web server 
Now you will publish the generated files to the WebSphere Application Server directories. 
Before you perform the export steps, you must map a network drive to the root directory of your 
Web server iSeries IFS environment.  
If you are unsure how to do this, please ask your instructor or follow these instructions. 
____  1.   Right-click the Network Neighborhood or (My Network Places) icon on the 

desktop. 
____  2.   Select Map Network drive from the pop-up menu. In the Folder Field of the Map 

Network Drive dialog, enter two backslashes (\\) and the Netserver name of your 
Web server. Ask your instructor for the exact name. The folder needs to include 
\root, for example, \\S400A\root 

 



WebFacing hands-on Lab                                                                       Page 214 of 220 

 
CW                                                                                                  © Copyright IBM Corporation 2002 

Course material may not be reproduced in whole or in part 
without the prior consent of IBM 

 

 
 
____  3.   Click the Finish push button.  
 
Exporting to the file system 
After the mapping is done, you can export to the file system: 
  
____  1.   Go back to the WebFacing Tool in the workbench of IBM WebSphere Development 

Studio Client. 
____  2.   Select File à  Export from the workbench menu bar. 

 
The Export page of the Select wizard opens. 

 
Completing the Select page 
____  1.   On the Select page, select the WAR file icon.  
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____  2.   Click the Next> push button. The WAR Export page opens. 
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Completing the WAR file export information 
____  1.   Select your WebFacing project from the export resources drop-down list. 

 
____  2.   In the Where do you want to export resources to? field, specify where to put the 

files by entering the drive letter and directory structure of your Web server. Ask your 
instructor what to use instead of wflabxx The directory will look something like this: 
x:\qibm\UserData\wflabxx\ 

   where x: is the drive you mapped from your iSeries network. 
____  3.   Click the Finish push button to copy the files to the WebSphere Application Server 

directories. 
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Creating a Web Application with the WebSphere Administrative Server 
admin console  
During this section you will start the WebSphere Administrative Server admin console, Version 
3.5. The console allows you to manage your WebSphere application server environment.  
 
 
Starting the WebSphere Administrative Server admin console 
____  1.   To start the console, open a DOS command prompt and type: 

             adminclient <server_name> <port_number> 

<server_name> is  the iSeries server that runs WebSphere Application Server. 
Important: This entry is case-sensitive. 
 
<port_number> 
Ask your instructor the correct bootstrap port number for the administrative server 
you use. This will take a while; please be patient until the console opens. 
 
This is the view you should see after the console comes up connected to the default 
administration server. 
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____  2.   Make sure that the console message box at the bottom of the view contains the 
message Console Ready. Then check whether the application already exists from 
a previous exercise.  

____  3.   Expand the Administrative Domain by clicking the plus sign (+) beside it, if it is not 
already expanded. 
 
The WAR file was generated in a WebSphere Application Server, Version 4.0 
environment, which is different from what is needed in Version 3.5. For this reason 
the Version 3.5 WebSphere Administrative Server admin console has a tool to 
convert the WAR file into a Version 3.5-compatible structure. The following steps 
take you through this process. 
 

____  4.   On the WebSphere Administrative Server admin console menu, select Console à  
Tasks à  Create a WAR file to start the wizard.  

____  5.   In the Select Servlet Engine  page, select the servlet engine to add your 
WebFacing application to. For example, select Default Servlet Engine .  

____  6.   Click the Next> push button.  
____  7.   On the Select Virtual Host page, select the virtual host that the application is to be 

run under. For example, select default_host.  
____  8.   Click the Next> push button.  
____  9.   On the Select War file to convert page, browse to where you have exported your 

WAR file to in the IFS.  
____  10.   When you are finished,click the Next> push button.  
____  11.   On the Select Destination Directory page, browse to the IFS directory you want 

the application installed to. For example, /QIBM/UserData/WebASAdv/<instance 
name>/hosts/default_host or 
/QIBM/UserData/WebASAdv/default/hosts/default_host/.  

____  12.   When you are finished,click the Next> push button. 
____  13.   On the Web Application Path and Web Application Name  page, in the Enter a 

Web Application Web Path field, type the Web path that will be used for your 
application. This value becomes part of the URL that will be used to access your 
WebFacing application. Enter wflabxx  

 
Example: 
If your server name is myserver and your instance of WebSphere Application Server 
is using the 9080 HTTP port, the first part of the URL to access your application 
would be http://myserver:9080. Using the Web Path value, the complete URL to your 
application would be<http://myserver:9080/<web_application_web_path>. When you 
enter the Web path value, include a forward slash at the beginning. For example, if 
your WAR file is called wflabxx.war and you decide to use a similar name for the 
Web path, you might enter a value like /wflabxx. In this example, the full URL to 
the application would be http://myserver:9080/wflabxx/. 

  
____  14.   On the Web Application Path and Web Application Name  page, in the Enter a 

Web Application Name  field, type wflabxx as a name for the application. When 
you have completed installing the WAR file, you will be able to administer, start, and 
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stop the application with the name that you chose. An icon representing your 
application will be listed under the servlet engine that you chose for the application.  

____  15.   Click the Finish push button.  
____  16.   Locate the new Application wflabxx icon under the Default Server Engine. 
____  17.   You will notice that the application is not active. 
____  18.   Right-click the application icon. 
____  19.   Select the RestartWebApp option from the pop-up menu. 

 
____  20.   If the Restart option is disabled, select the Application Server instance icon. 
____  21.   To stop the application server, right-click its icon and select Stop. 
____  22.   Wait until you see the message that the application has successfully been started. 
____  23.   Right-click the instance icon and select Start. 
____  24.   Wait until you see the message that the application has successfully been started.  
____  25.   This is all that needs to be done in the WebSphere Administrative Server admin 

console. Click the minimize button on the top right corner of the console. 
 

1. Note: 
Before you run the Application you need to change the Application server settings to 
support UTF-8. The WebFacing help text describes the steps required  

 
Running the Web-enabled application 
____  1.   Start Internet Explorer 
____  2.   Type the URL  http://servername:portnumber/wflabxx  
____  3.   The index.html page for your application should open. 
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Running the Web-enabled application 
____  4.   Start Internet Explorer 
____  5.   Type the URL  http://servername:portnumber/wflabxx  
____  6.   The index.html page for your application should open. 

 
 
 
 
 
 
 
 
 
 
 


